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What you should
already know

T3 ra e 3 o
= TErel

This preface contains the following:

e an overview of this manual

* a list of the documentation conventions used in this manual

* an overview of the BBN/Slate™ documentation

About this manual

BBN/Slate Getting Started introduces you to BBN/Slate multimedia
document communication software. This tutorial provides you with
practice exercises for learning the basics and offers suggestions for
using BBN/Slate’s more advanced features.

If you are new to BBN/Slate, Getting Started will get you up and
running. You do not need to have any previous experience with
the software to use this book.

If you have used BBN/Slate before, this book can give you new
ideas for using the software in your everyday work. You can also
use this book to remind yourself how to do basics tasks.

Before starting this tutorial, you should be familiar with your
workstation. You should know how to get in and out of your
windowing system and how to use a mouse.

If you are not comfortable using your workstation or do not know
how to get into your windowing system, read your workstation
documentation before continuing.
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How this book is
organized

Mouse
operations

This tutorial has eight chapters, each of which teaches you
something new about BBN/Slate.

Chapter 1 introduces you to BBN/Slate and tells you everything
you need to know to use this book.

Chapter 2 helps you start up BBN/Slate, shows you how to
create folders and files, and walks you through a sample
document.

In Chapter 3, you create a file and learn to use BBN/Slate’s
text editor.

Chapter 4 shows you the different ways to use BBN/Slate’s
electronic mail system. In this chapter, you learn to mail
existing documents and compose new messages.

In Chapter 5, you change information in a spreadsheet and then
create a new one. You also learn to analyze data and to make
a piechart.

Chapter 6 shows you how to add images from the file system
and create your own graphics.

In Chapter 7, you learn how to put your BBN/Slate documents
into printed form.

Chapter 8 gives you a glimpse of the other activities available
in BBN/Slate.

Documentation conventions for this manual

Unless otherwise noted in the text, this book uses the conventions
described in this section.

To tell you which mouse button to use and how to use it, this
book gives the button first, followed by the action.

The button can be the left, middle, or right button.

The action can be click, hold, drag, or release.
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Boldface font

Text you type

<RET> and
<TAB>

Menu options

For example:
left click

means you click with the left mouse button.

This boldface font, when preceded by a diamond, designates
actions you should take as part of the tutorial exercise. For
example, the following text:

¢ Left click on the compose button.

means that you click on the compose button using the left mouse
button.

Text that you enter in the editor appears in this font and is
indented from the margin. For example, you would enter the
following text in the editor:

Project Saturn is a software package that runs
on most workstations.

The Return and Tab keyboard keys are designated by <RET> and
<TAB> whenever they follow text that you type in. For example,
in the following text:

100 * 45 <RET>

you type the characters before the <RET>, and then press the
Return key.

Menu options are given with the form:

menuname-option
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[talic font

Monospace font

User
documentation

For example, the following menu option:
Text-Fonts-Face-Italics
shows that Text is the top-level menu, Fonts is a submenu of

Text, Face is a submenu of Fonts, and Italics is an option
of the Face menu.

This italic font identifies new terms and book names.

This monospace font indicates names of folders, documents,
buttons, and menus. For example, the following names all appear
in monospace:

+Welcome folder
Introduction document
show button

Print menu

Overview of BEBN/Slate documentation

The BBN/Slate documentation set includes the following manuals:

* Getting Started introduces you to BBN/Slate through a series of
tutorial exercises.

* The Reference Manual gives a complete description of the
BBN/Slate system.

* The Customizing Manual explains how you can tailor the
BBN/Slate system to fit your needs. Topics include
reconfiguring the menu system, and writing your own programs
using the Slate Extension Language (SEL).
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» System Topics is a collection of documents covering system
topics such as the structure of BBN/Slate document files,
command-line document management tools, and mail utility
programs.

*  Multilingual Documents describes how to create documents in
five other writing systems (Arabic, Cyrillic, Hangul, Hebrew,
and Thai) available with the BBN/Slate Multilingual Option.
Note: If you did not order the Multilingual Option, you will
not receive this manual.

On-line help In addition to the printed documentation, BBN/Slate has an on-line
menu help facility that provides information on all command and
menu choices. Also, BBN/Slate provides on-line UNIX manual
pages with information about BBN/Slate’s command-line programs
and utilities.

Installation and System-specific installation instructions and release notes
release notes supplement the BBN/Slate user documentation sct.
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Obtaining Documentat
and Services

This section explains how you can:

e order documentation
* obtain technical assistance

* obtain training services

How to order documentation

To order additional copies of this manual or any other BBN/Slate
manual:

* In North America, mail a completed purchase order to:

BBN Software Products

A Division of Bolt Beranek and Newman Inc.
10 Fawcett Street

Cambridge, MA 02138

ATTN: Sales Administration

For prices and other ordering information, call Sales Administration
at 617/873-5115.

*  Outside North America, contact the nearest Sales and Support
office.
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How to obtain technical assistance

For BBN/Slate customers who are on maintenance and need
technical assistance:

* In North America, call the Hotline number: 617/873-3968.
Hotline hours are Monday through Friday, 8:30 a.m. to 8 p.m.
(EST).

* Outside North America, contact the nearest Sales and Support
office.

How to obtain training

BBN supports its customers and products with a full range of
training programs. BBN/Slate courses are offered in conjunction
with hardware vendors or at BBN education centers. In addition,
arrangements can be made with the Education Services department
to present the same courses at customer sites.

To receive a course catalog or additional information:

* In North America, call the Course Registrar at 617/873-8383.

* Outside North America, contact the nearest Sales and Support
office.
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Creative
communication

Creating
documents

Introduction

Welcome to BBN/Slate multimedia document communication
software — a system designed to help you develop ideas and share
information. BBN/Slate gives you a complete set of integrated
tools normally found only in multiple software packages. Through
BBN/Slate’s document editor, you can use these tools to develop
multimedia documents and share them with people across the office
or around the world.

This chapter introduces you to the main features of BBN/Slate,
shows you how to use BBN/Slate in your everyday work, gives
you an overview of the BBN/Slate interface, and tells you how to
use this self-paced tutorial.

Using BBN/Slate for your everyday work

Think of BBN/Slate as a creative communication tool. Use it to
create your everyday documents as well as special materials for
presentations and meetings. However, don’t limit yourself to using
BBN/Slate just as a document-creation tool. You can also make
use of BBN/Slate’s communication abilities.

With BBN/Slate, you can create everything from on-line
newsletters to graphical presentation materials to reports. Any
document can contain any number of media types, from text to
graphics to speech.
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Communicating
information

Media types

You can communicate information using BBN/Slate’s electronic
mail facility, which lets you mail any multimedia document. You
can also confer with other users or attach voice annotations —
your own digitized speech — within any document. If you need
to share data with other users, use the BBN/Slate enclosure feature.

Cetting acquainted with BBN/Slate’s features

At the center of BBN/Slate is an integrated document editor, where
you create and modify multimedia documents. These documents
are made up of media types, such as text and graphics. BBN/Slate
gives you lots of features for working with documents in the
document editor.

BBN/Slate includes a full array of media types, including text,
spreadsheets and business graphs, images, graphics, digitized
speech, and enclosures. Each media type has its own editor that
you use to create and modify elements of that media type.

Text. Most of your multimedia documents will probably contain
text, although you don’t have to include text. The text editor lets
you choose from several type styles and sizes. If you have the
Multilingual Option, you can create text in languages other than
English.

Spreadsheets and business graphs. For presenting and analyzing
financial or other numerical information, you can create
spreadsheets. The spreadsheet editor lets you create line charts,
bargraphs, and piecharts, which you can easily generate from your
spreadsheets and regenerate whenever you change values or
formulas in the spreadsheet itself.

1-2 BBN/Slate Getting Started



Electronic mail

Electronic
conferencing

Graphics. In the graphics editor, you can create line drawings
complete with geometric shapes, fill patterns, built-in arrow styles,
and text.

Images. You can create or import your own images, which may
be scanned photographs, drawings, or screen captures from your
workstation display.

Digitized speech. With the proper hardware, you can insert and
play back digitized speech annotations. Using the speech media
type, you can make comments on documents you are reviewing or
just add a personal touch to a document.

Enclosures. Enclosures let you send files such as UNIX®
programs or data files to other BBN/Slate users. Depending on the
file you send, the recipient can edit, execute, and print the
enclosure.

Anything you can create in BBN/Slate, you can send through
electronic mail. Mail makes it easy for you to gather information
from other people and share your own ideas with others. Now
you can send documents containing the above media types through
the mail.

Because mailing a multimedia document doesn’t affect the media
types, recipients can work with the mailed copy as if it were an
original. For example, if you send a spreadsheet to someone to
review, that person could change some values and send the
spreadsheet back to you.

To help you collaborate more easily with others, BBN/Slate
includes a conferencing feature. Several people can confer over a
document, although only one person at a time has control over the
document. With the conferencing feature, you can reconcile
different opinions about a document or hold brainstorming sessions.
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Extension
Language

Similar to the conferencing feature, the conversation window lets
you type in a dialog with other users without carrying on the
phone conversation that you would have in a standard conference.

BBN/Slate’s built-in programming language lets you customize and
expand the system for yourself or for your work group. With the
Slate Extension Language (SEL), you can automate many of the
tasks you do every day.

Using the BBN/Slate interface

BBN/Slate works with your workstation’s windowing system. As
with other workstation software, you select menu options and
operate buttons by using a mouse, and if you like, keyboard
shortcuts.

This tutorial helps you become comfortable with the BBN/Slate
user interface by guiding you through the creation of a multimedia
document. After you finish with the tutorial, refer to the
BBN/Slate Reference Manual if you have any questions about the
user interface.

Using this book

This tutorial helps you learn BBN/Slate by walking you through
creating, sharing, and printing multimedia documents. To benefit
the most from BBN/Slate Getting Started, work through each
chapter in order, as the exercises build on each other.

In this tutorial, you learn how to work with most of the BBN/Slate
media types, including text, graphics, images, and spreadsheets and
business graphs. Each chapter teaches you how to work with a
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particular media type or feature. For instance, in Chapter 3, you
learn how to use the text editor by creating a document, and in
Chapter 4, you learn about electronic mail by sending, forwarding,
and reading messages.

The Epilogue (Chapter 8) gives you a glimpse of the other
activities available in BBN/Slate. Turn to the Epilogue to learn
about more advanced features of each of the media types and
about media types that this tutorial doesn’t cover. For more
information about any of the activities in the Epilogue, see the
Reference Manual.
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sarning the Basics

In this book, you assume the role of a product manager at a
high-tech company. You are currently managing the most recent
addition to your company’s product line — a software package
code-named "Project Saturn."

Your boss has asked you to present information about Project
Saturn at a company meeting in only a few days. Fortunately,
your company has just obtained BBN/Slate, and you and your boss
are confident that it will help you meet the tight deadlines facing
you.

While working through this book, you create presentation materials
that you will hand out at the company meeting. By creating these
materials, you learn about using BBN/Slate to make multimedia
documents and share information with others.

Excited about using BBN/Slate, you sit down at your workstation.
During this session, you:

* start BBN/Slate

* open folders and documents

* move through a document

* learn how to manage folders and files
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Starting BBN/Slate

Before you To work through this tutorial, you must have BBN/Slate already

begin installed on your system, and you should be in your windowing
system. If BBN/Slate is not already installed on your system, see
the BBN/Slate Installation Instructions to install the software
yourself, or have someone else do it for you before you continue.

Getting into Start BBN/Slate from within your windowing system.
BBN/Slate

¢ Enter your windowing system if you haven’t already.
¢ Enter the following command from within a window:

% slate <RET>

If you do not have BBN/Slate installed on your system, you see
this error message:

slate: Command not found

If you see this error message, you must first install BBN/Slate
before you can continue.

If you do have BBN/Slate installed, you see the following start-up
screen:

2-2 BBN/Slate Getting Started



v enC(<MailBox ) Yagsni 0t ofsilyselected g
4 Apr 90 Welcome to BBN/Slate Release 1.1
Document
manager
show ) (compose)(_send )(_cancel ) (_done ) [+Getting Started [2]
‘QMallbox £
Folder: |
(Cconf ) (_next )(_reply )(delete )
- BBN/Slate:Multimediai Document: Editor SN A SR e
Document
editor
Release 1.1
Used under license from
BBN Software Products Corporation
Copyright (¢) 1990 by
BBN Systems and Technologies Corporation
All rights reserved.
Done initializing multilingual text.

BBN/Slate start-up screen

BBN/Slate divides the start-up screen into two windows, a
document manager window, and a document editor window.

The document manager, divided into two sections, or panes, lists
all of your BBN/Slate folders and files. Below the document
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Using the mouse

manager is the document editor, where you work with BBN/Slate
documents. Depending on how your system has been set up, the
document editor may appear beside the document manager rather
than below it.

The top pane of the document manager, or document summary
pane, contains information about all of the BBN/Slate files in the
current folder. Non-BBN/Slate files in the folder (such as
bitmapped images) do not appear in the listing.

The bottom pane, or command pane, contains command buttons
that help you work with folders and files. You’ll learn how to use
these buttons later.

Document
names

4 BBN/SlatesiFoldergs=4<{Mailbox DDl 0 -of Blvselected Hanining
1 4 Apr 90 BBN

Welcome to BBN/Slate Release 1.1 T

Document
summary
pane

+Mailbox

+demo
Folder: |

(conf ) (Cnext )(reply )((delete )

(Cshow )  (compose)(__send )(Ccancel ) (_done ) [+Getting Started [3]

Folder names

Document manager

Before moving into the tutorial exercises, take a few minutes to
get familiar with using the mouse in BBN/Slate.
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The mouse has three buttons, each of which has a special function
in BBN/Slate:

e Use the left button to select folders, files, and media types
within documents.

¢ Use the middle button to display help messages and to perform
other specialized tasks.

» Use the right button to select and execute options from menus.

Select folders, files,
and media types

Display help and do
other specialized tasks

Select and execute options

Using the mouse

You use the mouse buttons by clicking, holding, and dragging. To
click, press the button and release. Sometimes, you may need to
double-click, or press the button twice quickly.

To hold, press and hold the button down. To drag, press the
button down, move the mouse (according to the task you are
doing), and release.

The instructions in this tutorial tell you the button to use and
whether to click, hold, or drag. For example, if the instructions
tell you to "Left click on the document name," then position the
pointer over the document name and click once using the left
mouse button.
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Opening folders and documents

BBN/Slate comes with a sample document designed to acquaint
you with the software. This document, called Introduction,
appears in a folder called +Getting Started. Your boss has
recommended that you look at this document before creating your
own BBN/Slate files.

Opening a In the document manager, you should see the folder name

folder +Getting Started, which contains the sample documents you
use while working through this tutorial. You also see a folder
called +Mailbox, which is where you receive mail, and a folder
called +demo, which contains more sample documents. All folders
in BBN/Slate begin with the plus sign (+).

If you are a new user and are working in your own account, you
should see only three folders in the folder list. If you don’t see
the name +Getting Started in the folder list, left click on
either set of arrows beside the list until you see the name.

45 BEN/SlatedFoldergsin<MailBox > D 0ot sselected iSRSNI
1 4 Apr 90  BBN Welcome to BBN/Slate Release 1.1

(_show ) (compose)( send )( cancel ) (_ done ) [+Getting Started [2]
+Mailbox

+demo
Folder:
(conf ) (_next J( reply )( delete ) (folderl save )

Left click on /
either set of arrows
to scroll through

the folder list

Moving through the folder list
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To open a folder, you highlight its name in the folder list and
click on the folder button.

¢ Using the left mouse button, click on the name +Getting
Started.

¢ Left click on the folder button.

| 4% BBN/Slate i Foldes#iz 2 (MailBox).) 388 0 jofeliselected Mg

1: 4 Apr 90 BBN Welcome to BBN/Slate Helse 1.1

(_show ) (compose)( send )( cancel ) (_ done )
“demo

Lfolderg (_save )

Left click \
here first Left click here last

Document manager

The contents of the +Getting Started folder appear in the
document summary pane.
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Contents of
folder

3 BBN/Slate:s Folderg==+GettingStarted Ji
A1 0% NS 08: Ma y: 908 s m) th s Prasentatio

2: N 08 May 90 smith SalesRegions
3: N 09 May 90 smith Introduction

(_show ) (compose)( send )( cancel ) ( done )
sdemo -
Folder: +Getting Started
(_conf ) (next )(_reply )( delete ) (folder ) (save )

Contents of the Getting Started folder

Opening a Your manager has told you that the document acquainting you with

document BBN/Slate is called Introduction. You want to see what the
document contains, so you open it and see it in the document
editor window.

To open a document, highlight its name and click on the show
button.

¢ Using the left mouse button, click on the document name
Introduction.

Once you’ve become more experienced with BBN/Slate, you will
have created many files, and all of your files in a given folder
may not be visible at once. If this happens, scroll through the list
by left clicking on the arrows in the scroll bar beside the document
summary pane.

¢ Left click on the show button.
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Left click Use these arrows to
here first scroll through the
list of documents
@ PBN/Slate i Eoldergs=%+GettingStarted g liofd3eselected;

1@ N D May 90 smith Presentation
2: N 08 May 90 smith SalesRegions

s 3 v N g 0 95 M a v 9 0is i t h st N tro dUC IO N ks s iniintnmmiisisaisiby e

("show )) (compose)( send )(cancel ) (_ done )

semo
Folder: +Getting Started
(“conf ) \(_next )( reply )( delete ) ( folder ( save )
Left click
here last

Opening a document

In a few seconds, the Introduction document appears in the
document editor.
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Add Edit File Mail Print Document Editor Keycaps Exit

Welcome to BBN/Slate TM Multimedia

&
Document Communication Software .

A new world

In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN/Slate
opens a new world of communication for both you and
your work group.

Multimedia communication

With BBN/Slate, you have a powerful, integrated system
for multimedia communication:

o a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

o a sophisticated document editor, where you create
and modify documents that can contain several
media types

0 an electronic mail interface, which allows you to

_HDle]

ol

Buffer: Introduction File: Introduction.sit

Document editor

Don’t worry that you can’t see all of the document. You’ll learn
how to move through a document in the next section.

Notice that you used the left mouse button to open folders and
files. In the next section, you use all three mouse buttons to move
through a document.
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Moving through a document

Whether creating, editing, or just reading a BBN/Slate document,
you need to know how to move around it quickly. You move
through a document using the scroll bars on the side and bottom of
the document editor.

ditoris

i BBN/SlateiMultimediaiDocuments ; SRR
Add Edit File Mail Print Document Editor Keycaps Exit

Welcome to BBN/Slate TM Multimedia
Document Communication Software

A new world

In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN/Slate
opens a new world of communication for both you and
your work group.

Multimedia communication

With BBN/Slate, you have a powerful, integrated system
for multimedia communication:

o a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

o a sophisticated document editor, where you create
and modify documents that can contain several
media types

an electronic mail interface, which allows you to

Vertical
scroll

Horizontal scroll bar bar

Scroll bars in the document editor

Most often, you’ll scroll through a document vertically, or page by
page. Sometimes, though, you may have to move horizontally to
see all of a wide spreadsheet or large graphic.
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Moving vertically Using the icons in the vertical scroll bar, you can move down and
up in a document. The next figure shows the arrows, page icon,
and edge icon in the vertical scroll bar. Notice that the icons
appear both at the top and the bottom of the scroll bar.

You’ll learn how to use these icons in the next few sections.

Add

#BBN/SlateiMultimediayDocumentiEditonuii

File Mail Print Document Editor KeycaMR

Edit

Arrows
Page icon

Edge icon \\

L1

Welcome to BBN/Slate TM Multimedia
Document Communication Software

A new world

In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN/Slate
opens a new world of communication for both you and
your work group.

Multimedia communication

With BBN/Slate, you have a powerful, integrated system
for multimedia communication:

o a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

0 a sophisticated document editor, where you create
and modify documents that can contain several

Scroll

bubble

S

media types
0 an electronic mail interface, which allows you to[]

7 Buffer: Introduction File: Introduction.sit

"/
Edge icon

Page icon
Arrows

Icons and scroll bubble in the scroll bar
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Scrolling a line at
atime

This figure also shows you the scroll bubble, which tells where
you are in the document. The length of the scroll bubble tells
how much of the document is visible, and the position of the
bubble within the scroll area tells which part of the document is
visible.

For instance, in this figure, the scroll bubble takes up about a third
of the scroll bar, which means that you are you are looking at
about a third of the document. The bubble is at the top of the
bar, which means that you are looking at the beginning of the
document.

First scroll through Introduction a line at a time. To move
down one line, you left click on either the top or bottom set of
arrows.

¢ Left click on either set of arrows.
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Left click on either

set of arrows N

| 98 BBN/SlatejMultimediagDocument: EditoriseeiSiiiiainasssnii s
Add Edit File Mail Print Document Editor Keg)paps N

Welcome to BBN/Slate TM Multi
Document Communication Softwa

A new world

In this age of information overload, most messages
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your informatibn
and concepts more effectively. As you become
experienced using the system, you'll find that BBNXSlate
opens a new world of communication for both you hnd
your work group.

Multimedia communication

With BBN/Slate, you have a powerful, integrated syst
for multimedia communication:

m

0 a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

o a sophisticated document editor, where you create
and modify documents that can contain several
media types

an electronic mail interface, which allows you to

rrd Buffer: Introduction  File: Introduction.sit

Scrolling down a line

The document scrolls down one line.
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Welcome to BBN/Slate IM Multimedia
Document Communication Software

B

A new world

In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, youwll find that BBN/Slate
opens a new world of communication for both you and
your work group.

Multimedia communication

With BBN/Slate, you have a powerful, integrated system
for multimedia communication:

o a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

o a sophisticated document editor, where you create
and modify documents that can contain several
media types

o an electronic mail interface, which allows.you to
distribute your multimedia documents to other

Buffer: Introduction File: Introduction.sit

After scrolling down a line

To scroll up a line, you right click on either the top or bottom set
of arrows.

¢ Right click on either set of arrows.
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Welcome to BBN/Slate TM Multimedia
Document Communication Software

A new world

In this age of information overload, most messages alte
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter bf
daily information and communicate your information
and concepts more effectively. As you become

experienced using the system, you’ll find that BBN/S
opens a new world of communication for both you ani
your work group.

te
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Multimedia communication

With BBN/Slate, you have a powerful, integrated syste
for multimedia communication:

o a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

a sophisticated document editor, where you create
and modify documents that can contain several
media types

an electronic mail interface, which allo

ws you to
= 7
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Scrolling up a line

You move back up to the first line of the document.

Remember: to move down through a document, left click. To
move up, right click.

2-16 BBN/Slate Getting Started




Paging through a
document

You can page through the document by using the page icons on
the vertical scroll bar. To move down a page, you left click on
either page icon.

¢ Left click on either page icon.

Left click on
either page icon

ultimedia Dotineiti Editor N
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Welcome to BBN/Slate TM Multimedia
Document Communication Software

A new world

In this age of information overload, most messages
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter\of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN/Slate
opens a new world of communication for both you an
your work group.

Multimedia communication

With BBN/Slate, you have a powerful, integrated systerg
for multimedia communication:

o a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

o a sophisticated document editor, where you create
and modify documents that can contain several
media types

0 an electronic mail interface, which allows you to

Buffer: Introduction File: Introduction.slt B

Paging down through a document

You move down one page.
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from other software systems

0 a sophisticated document editor, where you create
and modify documents that can contain several
media types

0 an electronic mail interface, which allows you to
distribute your multimedia documents to other
people

0 an electronic conferencing system, so you can

easily collaborate with others on creating and
revising multimedia documents

o a set of tools, which let you customize and expand
the BBN/S8late system to meet your personal needs
as well as the needs of your work group

Media types

BBN/Slate truly is a multimedia system because it lets
you mix several media types in one document. You are
now reading an example of a multimedia document!

All the BBN/Slate media types are briefly explained and
illustrated here:

Like a desktop publishing system, BBN/8late lets you
format text in different fonts, sizes, and type styles.

This is 10 point Helvetica in bold face.
This Is 74 point TV in italic.
This is 18 point Times Roman in

File: Introduction.slt

Buffer: Introduction

After moving down one page

To move up a page, you right click on either page icon.

¢ Right click on either page icon.
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Right click
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from other software systems

o a sophisticated document editor, whefe you create
and modify documents that can conta\n several
media types

B

o an electronic mail interface, which alldws you to
distribute your multimedia documents tp other
people

0 an electronic conferencing system, so you can

easily collaborate with others on creating\and
revising multimedia documents

o a set of tools, which let you customize and expand
the BBN/Slate system to meet your persona needs
as well as the needs of your work group

Media types

BBN/Slate truly is a multimedia system because it 1&ts
you mix several media types in one document. You\are
now reading an example of a multimedia document!

All the BBN/Slate media types are briefly explained and
illustrated here:

Text Like a desktop publishing system, BBN/Slate lets you
format text in different fonts, sizes, and type styles.

This is 10 point Helvetica in bold face.

This is 74 point TV in italic.
This is 18 point Times Roman in
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Moving up one page

You move up one page.

You can use either the top or the bottom arrow or page icons to
move through a document. Remember to left click on either icon

to move down and right click to move up.

Now read through the rest of the document by paging through it.
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Moving to the
beginning or end
of a document

¢ Left click on either page icon until you reach the end.

When you reach the end, the screen will look like this:

Hi BBN/Slate:MultimediaiDocumentsEditor;

File Mail Print Document Editor Keycaps
0O P D

: =qud ’ AlqQ-Ccopy osuaitpu O
With the previewer function, you can review a
document for page layout, page breaks, and line breaks
before printing.

Exit

Customization BBN/Slate comes with a set of tools that allow you both
to extend BBN/Slate’s power and to tailor the system’s
personal fit. In addition, with the built-in BBN/Slate
Extension Language (SEL), you can extend BBN/Slate’s
functionality and further enhance your BBN/Slate
multimedia environment.

Welcome to the new world of BBN/Slate
multimedia communication!

774 Buffer: Introduction File: Introduction.sit EZ

Paging to the end of a document

Edge icons move you to the beginning or end of a document. To
move to the beginning, you middle click on the top edge icon; to
move to the end, you middle click on the bottom edge icon.

Now that you’ve read through the Introduction document, you
decide to re-read something at the beginning, so you move there
using the top edge icon.
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¢ Middle click on the top edge icon.

Middle click
here

I\
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Add Edit File Mail Print Document Editor Keycaps E&\t
PIrevIEwWIIg TITETT=qUAIITY, ITIara-CcoOpy Ouipul O TOSUSTIIPT PTTITTETS) -

With the previewer function, you can review a é

document for page layout, page breaks, and line breaks
before printing.

Customization BBN/Slate comes with a set of tools that allow you both
to extend BBN/Slate’s power and to tailor the system’s
personal fit. In addition, with the built-in BBN/Slate
Extension Language (SEL), you can extend BBN/Slate’s
functionality and further enhance your BBN/Slate
multimedia environment.

Welcome to the new world of BBN/Slate
multimedia communication!
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Moving to the beginning of a document

You see the top of the document.
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Welcome to BBN/Slate TM Multimedia
Document Communication Software

A new world

In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you’ll find that BBN/Slate
opens a new world of communication for both you and
your work group.

Multimedia communication

With BBN/Slate, you have a powerful, integrated system
for multimedia communication:

0 a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

0 a sophisticated document editor, where you create
and modify documents that can contain several
media types

o an electronic mail interface, which allows you to

__HA[0]
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After moving to the top of the document

You can move to the end of the document in the same way.

¢ Middle click on the bottom edge icon.

2-22 BBN/Slate Getting Started



Add Edit File Mail Print Document Editor Keycaps Exit

Printing and Using BBN/Slate’s printing functions, you can produce

previewing high-quality, hard-copy output on PostScript™ printers.
With the previewer function, you can review a
document for page layout, page breaks, and line breaks
before printing,

D

Customization BBN/Slate comes with a set of tools that allow you both
to extend BBN/Slate’s power and to tailor the system’s
personal fit. In addition, with the built-in BBN/Slate
Extension Language (SEL), you can extend BBN/Slate's
functionality and further enhance your BBN/Slate
multimedia environment.

Welcome to the new world of BBN/Slate
multimedia communication!
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Middle /

click here
Moving to the end of the document

You move to the end of the document. This is the first time that
you’ve used the middle mouse button. Most of the time, you’ll
use only the left and right buttons.

Moving Most of the time you only need to move up and down through a
. horizontally document. If you have a wide graphic or large spreadsheet,
however, you may need to move horizontally to see the entire
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graphic or spreadsheet. You can move right and left in a
document using the icons in the horizontal scroll bar.

The following figure shows the arrows, page icons, edge icons, and
scroll bubble in the horizontal scroll bar.

Add

#BBN/Slatel MultimediaiDocument

Edit

T

L v S AT TRy sLiSn At

File Mail Print Document Editor Keycaps Exit

O

Printing and
previewing

Using BBN/Slate’s printing functions, you can produce
high-quality, hard-copy output on PostScriptT™ printers.
With the previewer function, you can review a
document for page layout, page breaks, and line breaks
before printing.

Customization BBN/Slate comes with a set of tools that allow you both

to extend BBN/Slate’s power and to tailor the system’s
personal fit. In addition, with the built-in BBN/Slate
Extension Language (SEL), you can extend BBN/Slate’s
functionality and further enhance your BBN/Slate
multimedia environment.

Welcome to the new world of BBN/Slate
multimedia communication!
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\ Scroll bubble
Edge
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Page
icon icon Edge  page Arrows
icon icon
Arrows
Horizontal scroll bar

2-24 BBN/Slate Getting Started



Like the vertical scroll bubble, the horizontal scroll bubble tells
where you are in the document. The length of the bubble tells
how much of the document is visible, and the position of the
bubble within the scroll area tells which part of the document is
visible. For example, in this figure, the scroll bubble takes up
almost the entire scroll bar, which means that you are looking at
nearly the whole width of the document.

Experiment on your own to learn to use the horizontal scroll bar.
If your document has a standard width, you can probably see most
of it without scrolling across. If you do scroll across and see a
blank screen, you can get back to the left-hand edge by right
clicking on either page icon until you see text again.

Use the following table to move across a document.

To Move Use this Action On this Icon

One space to the right Left click Arrows (either set)
One space to the left Right click Arrows (either set)
One page to the right Left click Page icon (either)
One page to the left Right click Page icon (either)
Right edge Middle click Right edge icon
Left edge Middle click Left edge icon

Moving across a document

Managing folders and files

After reading through the Introduction document, you decide
to put a copy in a separate folder called +New. Don’t worry
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Creating a
folder

about the document currently in the document editor; you manage
folders and files from the document manager, so it doesn’t matter
if a file is currently in the editor.

You create a new folder and then copy the Introduction
document into it. You also copy other files from the +Getting
Started folder into the +New folder.

To create a folder using existing documents, you select the files
you want to copy or move. You then name the new folder and
copy or move the files into it.

You are already in the +Getting Started folder, which is
where the original documents are stored. Now select the file you
want to copy and name the new folder.

If the name Introduction isn’t already highlighted, left click
on it once.

Erase the folder name +Getting Started by placing the
cursor at the end of the name and backspacing.
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B+ GettingiStarted i
Presentation
SalesRegions

PR N tro duCtion s

(Cshow ) (compose)(__send )(_cancel ) (_done ) (CEEAIINEIEUACUME 2|
+Mailbox

Folder: 4 _
(Cconf ) (Cnext )( reply )( delete ) &\folder) ( save )

\Backspace
to delete the
current folder
name

Erasing the existing folder name

¢ Type in the name of the new folder, +New, under the folder
summary box.

#BBN/Slate:Foldeng==g+ Getting:Started Siwe:
1@ N 08 May 90 smith Presentation
2: N 08 May 90 smith SalesRegions

i 3 e O 87 M) a Y2 O Diiis i t himissisostasign I trod UC O Nk

(" show (compose)(_send )(_cancel ) (_done ) +Getting Started;|EY
+Mailbox
+demo
Folder: +Newy _
(conf ) (Cnext )J( reply )( delete ) / (folder ) ( save )
7
Type in the
new folder
name here

Naming the new folder
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You have named the new folder. If you want to give a folder a
two-word name, separate the two words with an underscore,
period, or other distinguishing character.

Now copy files into it by using the save button.

¢ Right hold on the save button.

¢ Drag right to highlight the Copy Selected Documents to
Folder option as shown in the next figure. Release.

Presentation
SalesRegions

1t N
20 N

08 May 90 smith
08 May S0 smith

(_show ) (compose)( send )(_cancel ) (_ done )
teme

Folder: +Nevq

(cont ) (Cnext )(reply )(delete )

Copying a document to a new folder

This button, like all the buttons in the document manager, has an
underlying pop-up menu. When you left click on a button as you
did earlier to open folders and files, BBN/Slate automatically
selects the first option on this menu.

To select any of the other options, right hold to display the pop-up
menu. You can then choose the option you want by highlighting
the option and releasing.
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Copying several
documents at
once

You have now copied the file Introduction to your
+New folder. Now copy the files Presentation and
SalesRegions to the +New folder. You’ll use these docu-
ments in the rest of the tutorial.

You can copy several documents at once by holding down the
Shift key while you select them. First, deselect Introduction

so that you don’t copy it again.

¢ Middle click inside the document summary pane.

Middle click
here

1@ N 08 May 90 smith Presentation
20 N 08 May 90 smith SalesRegions
3 N 09 May 90 smith Introduction

(Cshow )  (comnpose)(_send )(cancel ) (_done ) [+Getting Started [2]
Now

s

Folder: +Newy

(_conf ) (_next )( reply )( delete ) (folder ) (save )

Deselecting a document name

The Introduction document is no longer highlighted. Now
select the other two documents.

¢ Hold down the Shift key.

¢ Left click on the names Presentation and SalesRegions
in the folder listing.

¢ Right hold on the save button.
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¢ Highlight the Copy Selected Documents to Folder

option. Release.

b

N

show ) (compose)( send )(_cancel )

(_done )

(_conf (" next )(_reply )(Cdelete )

Foider: +Newy

+Mailbox
+New
+demo

+Getting:Started:

g il GopyiSelectediDo

Copying more than one document

To check that you copied them correctly, display the contents of
the +New folder. Earlier, you opened a folder by highlighting its
name and clicking on the folder button. This time, use a shortcut
and double-click on the folder name to open it.

¢ Using the left button, double-click on the name +New in the

folder list.

All three files now appear in the document summary screen.
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Moving on
immediately

Optionally exiting

e W N e 09 @ INTroauG Con Sis
20 U Presentation
3 U 09 May 90 smith SalesRegions

(_show ) (compose)(_send )(cancel ) (_done ) [+Getting Started []
+aemo
Folder: +Newy

(_conf ) (_next )( reply )( delete ) (foider ) (save )

Contents of a newly created folder

To make sure that you copied the documents correctly, take a look
at one of them. Use the same shortcut to open the document.

Using the left mouse button, double-click on the name
Introduction.

The copy of Introduction appears in the document editor.
Because you didn’t alter the original Introduction document,
BBN/Slate removes it from the editor.

Going on to the next chapter

If you aren’t taking a break before moving on to the next chapter,
leave the Introduction document in the document editor. You
can skip over the rest of the next section and go on to the last
section, called "What you’ve learned."

You may want to rest before going on to Chapter 3. To leave
BBN/Slate completely and then come back to the tutorial, first exit
the document editor.
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To exit from the document editor, right hold on the Exit menu.
Drag down to select the Exit option and release.

48 BBN/Slate: MultimediaZDocime )
Add Edit File Mail Print Document Editor Keycaps

Welcome to BBN/Slate TM Multimedia
Document Communication Software

A new world

In this age of information overload, most messages are
ignored or quickly forgotten. Now that you have
BBN/Slate software, you can cut through the clutter of
daily information and communicate your information
and concepts more effectively. As you become
experienced using the system, you'll find that BBN/Slate
opens a new world of communication for both you and
your work group.

Multimedia communication

With BBN/Slate, you have a powerful, integrated system
for multimedia communication:

o a full array of media types, including formatted
text, graphics, images (in color or black and
white), spreadsheets, speech, and even an
enclosure media type for including information
from other software systems

o a sophisticated document editor, where you create
and modify documents that can contain several
media types

an electronic mail interface, which allows
et - -

Bz EEEEE7A Buffer: Introduction  File: Introduction.sit
iddle button describes the selected menu item.

Exiting from the document editor

The document editor closes. Next exit from the document
manager by clicking on the done button.
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here
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BRERSE | N troduc tIO NGRS R IRCT R R

R
20 U Presentation g
3 U 09 May 90 smith alesRegions :

(_show ) (compose)( send )( cancel ) E done ) [+Getting Started (2]
+demo

Folder: +Newy

(conf ) (next )( reply )( delete ) (folder ) ( save )

Exiting from the document manager

Your window manager iconifies the document manager and places
it on your desktop. You can now either exit from your windowing
system or stay within your windowing system and continue to
work in other programs.

What you’ve learned

In this session, you learned how to:

* start BBN/Slate
* open a folder
* open a document

* copy files from one folder to another

You will use these skills in your everyday work as well as in the
rest of this tutorial. In the next chapter, you learn how to create
text documents inside the document editor.
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Before you begin

Creating a Text Document

Reading through the Introduction document has made you
excited about the possibilities of BBN/Slate. Your presentation on
Project Saturn has given you the perfect opportunity to try out the
software.

You are to present Project Saturn at a company meeting in only
three days. Normally, you would have protested that three days
was not enough time to put together a presentation. After all, the
colleagues you need information from are located across the world.
But like you, these people also have BBN/Slate. Exchanging
complex information with them will now be as simple as sending
an electronic mail message.

You start by drafting an outline. In later chapters, you’ll send this
outline to your colleagues for feedback. During this work session,
you:

* work with text

* learn how to get help from BBN/Slate

* store a document

If you exited from BBN/Slate at the end of Chapter 2, first
re-enter the system. From your operating-system, get into
BBN/Slate as you did at the beginning of Chapter 2.

If you iconified the document manager, left click on the icon to
re-enter the system.
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Left click on this
icon to re-enter
BBN/Slate from the
desktop

Re-entering BBN/Slate

The document editor and document manager then appear.

Making sure you Before beginning, make sure that you are in the +New folder.
?’Z’j’” the correct Double-click on the name +New in the folder list to be sure you
older

are in the correct folder.

¢ Using the left mouse button, double-click on the name +New in
the folder list.

20 U 09 May S0 smith Presentatlo‘w
3 U 09 May 90 smith SalesRegions
(Cshow ) (compose)(_send )(cancel } (_done ) [+Getting Started
‘
+derno
Folder: +Ne

conf next reply delete folder save

p

/

Double-click here

Making sure you are in the +New folder
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Working with text

To create your outline, you open a new file and begin typing in

text.
Opening a To open a new file, you use the compose button in the command
new file pane and select the type of document you want to compose.

¢ Right hold on the compose button in the document editor.

o U 08 May 90 Smlth Presentation

3 u 09 May 90 smith SalesRegions
= : Message 7

((show ) irmeapnea)( From User Template =i ) [+Getting Started [3)
{From:Systemél emplatesms=| i +Mailbox

o L
Folder: +New)
(_conf ) (_next )( Yeply )( delete ) (folder ) (_save )

\

\ Right hold here to display a pop-up menu

The compose pop-up menu

This pop-up menu lets you choose the type of document you want
to compose. If an option on a pop-up menu is followed by an
arrow, that option leads to another menu, called a submenu. You
access a submenu by dragging further to the right until the
submenu appears.
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¢ Drag right to highlight the From System Template option.

¢ Drag further right to highlight the standard-doc option
from the submenu.

¢ Release.

| BBN/SlateFolders

Fol eRnaRe 09 | Ma.yi9 0@ smithalsssssu In troduc tioNEskas
20 U 09 May 90 smith Presentation

3 U 09 May 90 smith SalesRegions

+New it fofg34selecte

Message b
From User Template =k
‘omé Taks QuickStart

arabic -template

classified -doc

complex -doc :
hangul-template [

hebrew -template

conf next reply delete | MemMo . -save

( J L )( simple -doc \
slate-bug i
slate -wish .
sstandard ~doc s

viewgraphs

B A

Selecting a standard document format

A blank buffer appears in the document editor. A buffer is a
temporary storage area where you work on your document before
storing it in a file.

The name of the buffer (in this case standard-doc) and the
name of the file appear at the bottom of the document editor.
Since you have just opened this document and have not saved it to
a file yet, you see no file name at the bottom of the editor.
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Buffer: standard-doc File: [none]
/usr/slate/lib/templates/standard-dpc.sit was an empty]ffile.

Buffer name File name

Blank buffer in the document editor

The standard-doc option is a template. BBN/Slate comes with
several templates, or documents containing certain text styles,
which you can use over and over again. When saving a document
created from a template, you save only the document itself. The
template remains blank so that you can use it again. You can also
create your own templates. See the BBN/Slate Reference Manual
for information on creating templates.
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Entering text You can begin entering text. Start by creating an opening
paragraph for your outline.

¢ Move the pointer inside the document editor window.

Placing the pointer inside the window makes it active. You can’
work in a window unless it is active.

¢ Right hold inside the document editor to bring up the Text
menu.

t

i BBN/Slate:Multinie:

Add Edit File Mail Print Document Editor Keycaps Exit

Text

Add
Fonts
Language
Styles
Edit
Counters
Group
Ungroup
Search...
Select
Lists

Describe Item..

L ;f:/,”,//jf-’: i f/;/ i
7 Buffer: standard-doc  File: [none] FZZ
iddle button describes the selected menu item.

B

Bringing up the Text menu
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The Text menu is a pop-up menu that appears whenever you
right hold inside a text area. Each media type — including text,
graphics, spreadsheets, and others — has its own pop-up menu.

Highlight the Add option, and drag right to display the next

submenu.

Notice all of the options you have on this submenu. Each of these
options, from caption-figure to itemization, represents a
text style. BBN/Slate has lots of different text styles, and you can
also create your own.

¢ Highlight the noindent option. Release.

Language
Styles
Edit
Counters
Group
Ungroup
Search...
Select
Lists
Descri

5

by
g caption-figure p

be Item.| subtitle

R

caption-table
center
chapter
example
itemtag .
snoindent: gk
paragraph
right
section
subsection

table

title
toc~body 1
toc ~-body2
toc -title
usertag
verbatim
description
enumeration
itemization

Selecting the noindent style

The cursor appears on the margin.
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Cursor ready for text

¢ Type in the following text:

Easy to learn and to use, Project Saturn should
become a bestseller. Project Saturn is a
software package that runs on most workstations.

The text should look something like this:

i BBN/Slate:MultimediakDocument:Edito e
Add Edit File Mail Print Document Editor Keycaps  Exit

Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software package that runs on most workstations. 4

Typing a paragraph
Correcting If you make any mistakes, you can correct them using the Delete
mistakes or Backspace key. If you find a mistake after typing in the whole

paragraph, you can move back to the mistake using the arrow keys
or by pointing and clicking with the left mouse button.
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For example, if you had misspelled the word package as in the
following figure, you would move the pointer inside the document
editor and left click after the mistake.
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Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software pcakge that runs on most workstations.

Correcting a misspelled word

You would then press Backspace or Delete to delete the incorrect
letters, and type in the correction.

- T
i A N i
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Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software packageg that runs on most workstations.

Typing in the correct letters

Adding a After you type in the paragraph, you think of an idea for a
heading heading and decide you want the heading centered.

¢ Place the cursor before the first word in the paragraph by
pointing and left clicking.
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fasy to learn and to use, Project Saturn should become a bestseller. Project Saturn
Is a software package that runs on most workstations.

Placing cursor at the beginning

You’ve placed the cursor at the very beginning of the document
and are ready to enter the centered heading.

¢ Right hold inside the document editor to bring up the Text
menu.

¢ Highlight the Add option, and drag right to display the next
submenu.

¢ Drag right and down to highlight the Center option.
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e cption-figure

caption~table
Language Jcenterinbni
Styles chapter
Edit example
Counters itemtag
Group noindent
Ungroup paragraph
Search... right
Select section
Lists subsection
Describe Item.| subtitle

table

title
toc-body1
toc~body?2
toc ~title
usertag
verbatim
description
enumeration
itemization

oo

L R 1552
R Buffer: standard-doc* File: [none]
iddle button describes the selected menu itemn. |

Adding centered text

Release.

The cursor moves to the center of the line, and you are ready to
enter the text of the heading.
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Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software package that runs on most workstations.

Cursor ready for centered text

¢ Type in the text for the heading, as shown below:

Saturn: Up and Coming in a Growing Market

As you type, BBN/Slate centers the text in the middle of the line.
When you are finished, the heading should look like this one:

| §iBBN/Slate:MultimediagDocumentiEditorsiissssaminnissi
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Saturn: Up and Coming in a Growing Market )

Easy to learn and to use, Project Saturn should become a bestseller, Project Saturn
is a software package that runs on most workstations.

After adding a centered heading

Adding a You are ready to begin your outline. Because your ideas are

list sketchy, the outline will not be very formal or detailed. You start
by making a list of the three major points you want to make at the
presentation.

¢ Place the cursor at the end of the paragraph and left click.
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Saturn: Up and Coming in a Growing Market &

Easy to learn and to use, Project Saturn should be_come a bestseller. Project Saturn
is a software package that runs on most workstationsy

Cursor before beginning a list

¢ Right hold to bring up the Text menu. Drag down to
highlight Add, then drag right and down to highlight
enumeration. Release.

3
ki ...4 caption-figure
Fonts caption~-table

Language center
Styles chapter
Edit example
Counters itemtag
Group noindent
Ungroup paragraph
Search... right
Select section
Lists subsection
subtitle
77 table
title
toc-body 1
toc-body2
toc -title
usertag
verbatim
description

‘enumerationus:
itemization

Adding an enumerated list

The number 1 appears automatically in the left margin. If you
didn’t select the correct text style and do not see a number 1 on
the margin, press the Backspace or Delete key until you return to
the end of the paragraph and then begin again.
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In addition to enumerated lists, BBN/Slate has lists beginning with
descriptions (description) and bullets (itemization). You

can also create your own list styles.

A e

3 BBN/SlateiMultimediagDocuments Editorai ¥
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Saturn: Up and Coming in a Growing Market

Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software package that runs on most workstations.

1. A

Cursor ready to begin a list

Now type in the three major points.

¢ Type in the list of points as shown below: At the end of each
list item, press Return:

How does Project Saturn stack up against the competition?
<RET>

What are our forecasted sales in Europe? <RET>

How can we achieve these forecasted sales? <RET>
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Saturn: Up and Coming in a Growing Market

Easy to learn and to use, Project Saturn should become a bestseller, Project Saturn
is a software package that runs on most workstations.

1 How does Project Saturn stack up against the competition?
2 What are our forecasted sales in Europe?

3. How can we achieve these forecasted sales?
4

A

Typing in an enumerated list
When you press Return, the number for the next list item appears.
After you press Return following the third item, a number 4

appears. Since you only want three items, end the list here.

& Press Return once more to end the list.
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Saturn: Up and Coming in a Growing Market

Easy to learn and to use, Project Saturn should become a bestseller, Project Saturn
is a software package that runs on most workstations.

1. How does Project Saturn stack up against the competition?
2. What are our forecasted sales in Europe?
3. How can we achieve these forecasted sales?

A

Ending a list

Notice that the last number (in this case, 4) is now gone. You can
end any list by pressing Return twice.

Embedding Now that you have the major points sketched out, you are ready to
lists add some subpoints. With BBN/Slate, you can easily embed lists
within lists.
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Start by adding three subpoints below the first major point.
¢ Place the cursor at the end of the first list item. Left click.
¢ Right hold to bring up the Text menu. Drag down to

highlight Add, then drag right and down to highlight
enumeration. Release.
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Saturn: Up and Coming in a Growing Market

Easy to learn and to use, Project Saturn should become a bestseller, Project Saturn
is a software package that runs on most workstations.

1. How does Project Saturn stack up against the competition?

2.  What are our forecasted sales in Europe?

3. How can we achieve these forecasted sales?

I7 o 6pti0n ~figure f
Fonts caption-table

Language center .
Styles chapter i
Edit example i
Counters itemtag
Group noindent
Ungroup paragraph
Search... right
Select section
Lists subsection
Describe Item.{ subtitle
wETTTEEE table
title
toc-body 1
toc-body?2
toc -title
usertag
verbatim
description
A4 ienumerationisiE
T itemization tandard-doc* File: [none] [
iddle button desc TZEEEw R enu items.

Adding an embedded list

A new line appears beginning with the letter A.
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Saturn: Up and Coming in a Growing Market )

Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software package that runs on most workstations.

1. How does Project Saturn stack up against the competition?
A4

2. What are our forecasted sales in Europe?
3. How can we achieve these forecasted sales?

Cursor ready for an embedded list

Now enter the text of your subpoints.

¢ Type in the text of subpoints A, B, and C as shown below. At
the end of each list item, press Return:

Available on multiple workstations <RET>

Consistent look and feel <RET>
Easy to learn <RET>

The text should look like the list in the next figure.
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Saturn: Up and Coming in a Growing Market

Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software package that runs on most workstations.

1. How does Project Saturn stack up against the competition?

A.  Available on multiple workstations
B.  Consistent look and feel
C. Easy to learn
b 4
2. What are our forecasted sales in Europe?
3. How can we achieve these forecasted sales?

Embedding a list

When you press Return at the end of subpoint B, you added a,
third subpoint. You delete it using the Delete key. :

¢ Press the Delete key to get rid of the letter D.

|4 BBN/SlatezMultimediai Document
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Saturn: Up and Coming in a Growing Market

Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software package that runs on most workstations.

1. How does Project Saturn stack up against the competition?

A, Available on multiple workstations
B.  Consistent look and feel
C. Easy to learny

2. What are our forecasted sales in Europe?
3. How can we achieve these forecasted sales?

Ending an embedded list
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Adding to
the main list

If you ended the sublist by pressing Return twice, you have an
extra line in between subpoint C and point 2. Delete it by
pressing the Delete key.

While adding the subpoints to number 1, you thought of another
main point. You make it the new third point.

¢ Place the cursor at the end of the second major point. Left
click.

& Press Return to add a new list item.
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Easy to learn and to use, Project Saturn should become a bestseller., Project Saturn
is a software package that runs on most workstations.

1. How does Project Saturn stack up against the competition?

A.  Available on multiple workstations
B.  Consistent look and feel
C. Easy to learn

2.  What are our forecasted sales in Europe?

34
4, How can we achieve these forecasted sales?

Adding a new list item
¢ Type in the text shown below. When you reach the end, don’t
press Return:

What are our forecasted sales in the United
States?

When you are finished, the list should look like the one in the
following figure.
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Saturn: Up and Coming in a Growing Market

Easy to learn and to use, Project Saturn should become a bestseller. Project Saturn
is a software package that runs on most workstations.

1. How does Project Saturn stack up against the competition?

A, Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2,  What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

©

Adding to the main list

This time you ended a list item by not pressing Return. If you
did press Return, you can delete the new number 4 by pressing the
Delete or Backspace key.

Notice that the system renumbers the list items. Your new list
item automatically becomes number 3, and the old number 3
becomes number 4.

Cutting and You read what you’ve produced so far. It looks fine, but the first
pasting text paragraph isn’t quite right. You decide to move the second
sentence to the beginning of the paragraph.

¢ Place the cursor at the beginning of the second sentence. Left
drag all the way to the end of the paragraph. Release.

The second sentence is highlighted. Whatever option you choose
now will affect only the highlighted text.

3-20 BBN/Slate Getting Started



T e,

gi:BBN/SlateiMultimediaiDocumentiEditorg@i
Add Edit File Mail Print Document Editor Keycaps Exit

Saturn: Up and Coming in a Growing Market

Easy to learn and to use, Project Saturn should become a bestseller. JTIEEALIL
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1. How does Project Saturn stack up against the competition?

A.  Available on multiple workstations
B.  Consistent look and feel
C. Easy to learn

2.  What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

Highlighting text

Now cut the text using the Edit-Cut option from the Text
menu.

< Right hold to bring up the Text menu. Drag down to
highlight the Edit option, then drag right to highlight the Cut

option. Release.
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Easy to learn and to use, Project Saturn should become a bestseller.

iszavsoftwareipackagesthatéruns:on-mostiworkstations.

1. How does Project Saturn stack up against the competition?

A.  Available on multiple workstations

B. | Text B feel

c. | Add
Fonts
2.  Wha{ Language =
3.  What Styles SHsale tes?
a How BG 3
Counters Copy
Group Clear
Ungroup Paste
Search... Copy To Selection
Select Paste From Selection
Lists Split
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Buffer: standard-doc* File: [none] I
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Cutting text

The text disappears. Now paste the text at the beginning of the
paragraph.

¢ Place the cursor at the beginning of the paragraph. Left click.

¢ Right hold to bring up the Text menu. Drag down to

highlight the Edit option, then drag right to highlight the
Paste option. Release.
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Buffer: standard-doc* File: [none] [
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Pasting text

The text appears in its new position. By cutting the text, you
placed it on a temporary clipboard, or storage area. When you
pasted the text, you retrieved it. The clipboard can hold one item
at a time (i.e. one chunk of text, one spreadsheet, or one graphic)
and replaces it with the next item you cut or copy.

Creating a Text Document 3-23



Document  Editor Keycaps  Exit

0

Print

Saturn: Up and Coming in a Growing Market
Project Saturn is a software package that runs on most workstationsgEasy to learn
and to use, Saturn should become a bestseller.

1. How does Project Saturn stack up against the competition?

A, Available on multiple workstations

B.  Consistent look and feel

C. Easy to learn
2 What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

@ on

Document with pasted text
Now add two spaces to separate the two sentences.

¢ Press the Spacebar twice.

The paragraph should now look like this:

Editor ity RN
Document  Editor Keycaps  Exit
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Saturn: Up and Coming in a Growing Market

Project Saturn is a software package that runs on most workstations, fasy to
learn and to use, Saturn should become a bestseller.

1. How does Project Saturn stack up against the competition?

A, Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2 What are our forecasted sales in Europe?
What are our forecasted sales in the United States?

@

4. How can we achieve these forecasted sales?
After adding spaces
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Editing the The first sentence doesn’t sound quite right yet, so you edit it.
text

¢ Left click before the word "Project" in the first sentence.
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Saturn: Up and Coming in a Growing Market
Easy to

‘F’roject Saturn is a software package that runs on most workstations.
earn and to use, Saturn should become a bestseller,

1. How does Project Saturn stack up against the competition?

A, Available on multiple workstations

B.  Consistent look and feel

G, Easy to learn
2 What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
How can we achieve these forecasted sales?

@

Document after deleting text
Type in a new beginning.

¢ Type in the following text:

The most recent addition to our product line,

¢ Press the Spacebar once.
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After editing, the first paragraph should look like this:
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Saturn: Up and Coming in a Growing Market )

The most recent addition to our product line, Project Saturn is a software package
that runs on most workstations. Easy to learn and to use, Saturn should become a
bestseller.

1. How does Project Saturn stack up against the competition?

A,  Available on multiple workstations
B.  Consistent look and feel
C. Easy to learn

2.  What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

@

Document with new text

Changing Now that you have the content of your outline finished, you want
the type style to improve the way it looks. You decide to change the type style
of the entire document.

¢ Right hold on the Document menu at the top of the document
editor. Drag down to highlight Set Language/Font.
Release.
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Saturn: Up and Coming Find Object

Check Spelling
The most recent addition to our product lingg TR W are package
that runs on most workstations, Easy to Iearn and to use, Saturn should become a

bestseller.

1. How does Project Saturn stack up against the competition?

A,  Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2, What are our forecasted sales in Europe?
What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

@

Changing the document font

The menus that appear on the menu bar at the top of the document
editor control the entire document. Think of the menu bar as a
control panel for the whole document and the pop-up menus inside
the editor as control panels for individual media types.

You can select menus from the menu bar using either the left or
right mouse button. Use the button that feels comfortable to you.

When you select the Set Language/Font option, a dialog box
appears on the screen. BBN/Slate uses dialog boxes to prompt you
for the information it needs to do a particular task.

In this case, BBN/Slate asks you to set the language and font for
the entire document. If you have the Multilingual Option, you
could use this menu to set the language script (such as Russian or
Hebrew) of the document. Right now, you are only using it to set
the font family and font size.

Left click on the cycle button beside Family until you see
timesroman appear.

Creating a Text Document 3-27



Document Language

Language 7 English .
Paragraphxf-—'/low: Left-to-Right o Left click
] here

Document F2:74
Family IS elvetica

Face o Normal
Size 10 pt
O underlined

[[ OK J] [Cancel)

Changing the font family

You can select items from a cycle button by left clicking until the
choice that you want appears, or you can display a menu by right
holding on the cycle button.

¢ Right hold on the cycle button beside Size to display a
pop-up menu. Drag right to highlight 12 pt. Release.

¢ Left click on OK.

Document Language
Language £ English
Paragraph Flow: Left-to-Right

Document Font

Family etw

Face N 10 pt

Size gl 24ptyd
Tt

R
O underlined

e~

™ Right hold
[[_ox J ((cancel ) here to display
pop-up menu

Changing the font size

The text in the entire document now appears in a different font.
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Editing the Next, you continue to enhance the look of the document by
heading making the centered heading larger and boldface.

¢ Place the cursor at the beginning of the heading. Left click.
¢ Right hold to display the Text menu. Drag down to highlight

Styles. Drag right to highlight Local Change and then
center. Release.
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pSaturn: Up and Coming in a Growing Market k]

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.

1. How iin stack up against the competition?

A, = itiple workstations

: Language 5l

LA Styles s Local: Changemlcente 1

C. | Edit Global Change e
Gounters

2. What| Group Greate
Ungroup Switch . 9
What Search... Delete ted States
4. How | Select males?
Lists

Descrlbe Item

Buffer standard-doc* File: [none]
lddle button describes the selected menu item.

Changing a text style locally
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A dialog box appears. This dialog box contains information about
the text style center. Because you are making a local (rather
than a global) change to the text style, any changes you make in
this dialog box affect only the instance of the text style at the
Cursor.

Change the type face and size by clicking on the Face and Size
cycle buttons.

¢ Left click on the Face cycle button until Bold appears.
¢ Left click on the Size cycle button until 14 pt appears.

¢ Left click on the OK button.
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here twice
Left click
/ here once
/ /
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Font /
Family &/ jnesroman & Word wrap O Width derived
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Size ""12 pt Page break £ None
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tr 1t
Left Margin: Oi Indent: 0i White Above: 0i
Linewidth: Oi White below: 1l

Right Margin: Oi

Spacing Justification
= = = = Language £ English
Paragraph Flow: Left-to~Right

l

lTab stops: 0.5i I

lGontent: l

[Print Values: ]

[Next Style: 1

[[ . OK ]] (Cancel ]
[

/
Left click here
when you
are finished

Changing the type size and face

The larger, bolder heading appears.
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Saturn: Up and Coming in a Growing Market [3

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.

1.  How does Project Saturn stack up against the competition?

A. Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2. What are our forecasted sales in Europe?
3. What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

Document with enlarged heading

Accessing on-line help
Satisfied with your new document, you are ready to store it and
take a coffee break. You aren’t sure how to store your document,

so you use BBN/Slate’s help system.

Getting help To get help, use the middle mouse button. You can middle click
on menus, menu options, and buttons to find out what each does.

¢ Middle hold on the Edit menu on the menu bar.

3-32 BBN/Slate Getting Started



ultimediazDocumentiEditoril

Add _ Bdit | Cut, copy, paste, or modify display attributes for the

selected region of a document.
paturn: Up and Coming In a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller.

1. How does Project Saturn stack up against the competition?

A, Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2. What are our forecasted sales in Europe?
3, What are our forecasted sales in the United States?
4,  How can we achieve these forecasted sales?

Buffer: standard-doc* File: [none]
iddle button describes the selected menu item.

Getting help on the Edit menu

You see a help message explaining that the options under the
Edit menu cut, copy, paste, and modify display attributes.
Because you don’t see anything about storing, you look for help
on another menu.

¢ Release.

Middle hold on the File menu on the menu bar.
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paturn: Up and Coming in a Growing Market (&)

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations., Easy to learn and to use, Saturn
should become a bestseller.

1. How does Project Saturn stack up against the competition?

A. Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2. What are our forecasted sales in Europe?
3. What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

5 G
Buffer: standard-doc* File: [none]
iddle button describes the selected menu itern.

Getting help on the File menu

The help message tells you that you can use the File menu to
store documents.

¢ Release.
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Saving a
document

Storing a document

When you work on a file, you work on a copy of it in a buffer

rather than on the file itself. After you’ve finished editing it, you
can store your changes to the file or abandon the changes. After
using the help system, you know that you use the File menu to

store documents.

To save a document, you use the Write-New File option under
the File menu.

¢ Right hold on the File menu on the menu bar.

¢ Drag down to highlight the Write option, then drag right to

highlight the New File option. Release.

Print Document Editor Keycaps Exit

n. a Growing Market

package that run.™

should become a bestsell| As Template...
To Program.
1.  How does Project 3¢®

nst the competition?

A. Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2. What are our forecasted sales in Europe?
3, What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

Saving a file

You see a dialog box that asks you to type in the name of the new
file.
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Write to file:

[ ust | oK

( cancel |

Dialog box for saving a file

You name the file Outline by typing the name in the dialog
box. BBN/Slate accepts names in upper or lower case or any

combination of the two.

¢ Type in the name Outline.

€ Left click on the OK button.

Write to file:

!Outlinq

(st ] oK

( cancel |

Naming a file

In many dialog boxes, including this one, you can press Return

instead of clicking on OK.

Your outline is saved in a file called Outline in your +New
folder. Keep the outline in the document editor because you will
work on it in the next chapter. If you want to exit from
BBN/Slate before moving on to the next chapter, leave the system

as described at the end of Chapter 2.
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What you’ve learned

As you created your outline, you learned how to:

« enter and edit text

* cut and paste blocks of text
* change text fonts and sizes
+ get help

e save a document

You’ve also learned how to use the mouse buttons to select text
and menus within the document editor. In the next chapter, you’ll
mail the document you just created.
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Before you begin

Using Electronic Wail

After finishing your outline, you decide to send it to a colleague
who works on Project Saturn and ask for a review of the structure.

In this chapter, you:

* send a document which includes some additional comments for
your colleague

e compose and send a new message

* receive mail

Because you are working in an imaginary scenario, you can’t
really send electronic mail messages to people working on Project
Saturn. Instead, you’ll send the messages to yourself. In the real
world, you would replace your own name in the electronic mail
header with the name of a real recipient.

Before beginning, make sure that you are in the +New folder and
that the document Outline which you created in the last chapter
is displayed in the document editor.

If you exited BBN/Slate at the end of the last chapter, first re-enter
the software as shown at the beginning of Chapter 3. Then open
the +New folder and the document called Outline.

Sending a document

You want a colleague to take a look at your outline on Project
Saturn. Before sending it, you need to add a few additional
comments for your colleague.
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Adding If you send this document now, your colleague probably won’t

explanatory know why you’ve sent it. You add some comments to explain the

comments outline by selecting the Add-noindent option from the Text
menu. This option tells the text editor to add a new text style, in
this case, a style called noindent. The noindent style is a
paragraph block without an indented first line.

¢ Left click at the beginning of the centered heading.

¢ Right hold to bring up the Text menu. Highlight the Add
option, then highlight the noindent option. Release.

I
.4 caption-figure j
caption-table
Language | center

Styles chapter
Edit example
GCounters | itemtag :
Group ‘noindentilsgs |

Ungroup paragraph
Search... right
Select section
Lists subsection
Info... subtitle
cromrrm table

title

toc -body 1
toc ~-body?2
toc -title
usertag
verbatim
description
enumeration
itemization
A Sy SRS GS %

Adding a new text style

The cursor is ready for you to enter your text.

4-2 BBN/Slate Getting Started



BN/Slate;MultimediaisDocumentiEdito = - T
Add Edit File Mail Print Glassify Document Editor

Keycaps Exit

=l

Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations, Easy to learn and to use, Saturn
should become a bestseller.

1.  How does Project Saturn stack up against the competition?

A. Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2.  What are our forecasted sales in Europe?
3, What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

Buffer: standard-doc* File: [none] [

Cursor ready for comments

¢ Enter the following comments:
Sal-- <RET>

Project Saturn is really on a roll. I'm giving a
presentation on how Saturn stacks up against the
competition at a company meeting in just three days.
Since this is your subject area too, can you give me
some feedback on this outline? <RET>

<RET>

Thanks-- <RET>

Your name <RET>

Using Electronic Mail 4-3



Sending the
message

After adding the comments, your outline should look like the one
below. Note that the user’s name in this case (and throughout this
chapter) is Chris Smith.

W:BBN/Slate: T

Add Edit File Mail Print Classify Document Editor Keycaps Exit
wal-- a
Project Saturn is really on a roll. I'm giving a presentation on how [}

Saturn stacks up against the competition in just three days. S8ince this is
your subject area too, can you give me some feedback on this outline?

-

Thanks--
Chris Smithy

Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations, Easy to learn and to use, Saturn
should become a bestseller.

1. How does Project Saturn stack up against the competition?

A. Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2. What are our forecasted sales in Europe?
3. What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

777 Buffer: standard-doc* File: [none]

Outline with explanatory text

After adding the explanation, you are ready to send the outline.
To send a message already in the document editor, you use the
Send option from the Mail menu on the menu bar.

¢ Right hold on the Mail menu on the menu bar. Highlight the

Send option, then highlight the Send as Multimedia
option. Release.
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sal-- sen

Project Saturn is r{ Heply
Saturn stacks up ag{ Forwarg
your subject area to{ Ganuel

a presentation on how
ree days. Since this is
Tback on this outline?

Thanks--
Chris Smithy

Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. FEasy to learn and to use, Saturn
should become a bestseller.

1. How does Project Saturn stack up against the competition?

A, Available on multiple workstations
B. Consistent look and feel
C. Easy to learn

2.  What are our forecasted sales in Europe?
3,  What are our forecasted sales in the United States?
4, How can we achieve these forecasted sales?

P57 Buffer: standard-doc* File: [none]
piddle button describes the selected menu item.

Sending a multimedia mail message

Usually, you use the Send as Multimedia option when you
are sending a document containing media types other than text.
Here, you send a text message as multimedia just for practice.

BBN/Slate attaches a mail header to your outline and displays a
dialog box in which you enter information. This is the
information BBN/Slate needs to deliver your messages.
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EMultimedi

Add Edit File g el Print  Classify Document Editor Keycaps Exit
sal-- a

DacumentzEdit

Project Saturn is really on a roll. I'm giving a presentation on how ]
Saturn stacks up against the competition in just three days. Since this is
your subject area oo, can you give me some feedback on this outline?

anke—-

Th

cyl [Toig ]
[Subject: |
[cc: ]
Alternate fields (name: value)

T :

P

S

Io (e NI

[ OK )] [CancelJ

] Buffer: standard-doc* File: [none]
iddle button describes the item under the pointer.

Document with mail header and dialog box

Filling out When you fill out a mail header, you tell BBN/Slate who to send
a mail header the document to. You can also add a subject line and send copies
to other people. You enter this information in fields.

¢ Type in your own user name in the To field. Press Return.
Normally, you would type in the name of the person to whom you

want to send the document. In this exercise, you send all mail to
yourself.
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© Type in the following subject line. Press Return:

Outline for Project Saturn presentation <RET>

The mail header should now look something like this.

Type in your own username here

/

—
To: smith
Subject: Outline for Project Saturn presentationy
CC:
Alternate fields {(name: value)

[[ OK JJ [Canceu

Filling out a mail header

You don’t want to send copies to anyone, so you leave the CC
field blank.

The alternate fields listed below the CC field give you space to
create your own categories in the mail header. For instance, you
might want to rank the urgency of your mail by creating an
Importance field similar to the Subject and CC fields. You
could then identify a high priority message by labeling it
URGENT, as shown in the following figure. (Following a
standard UNIX electronic mail convention, you should start any
personal fields such as this one with an X-.)
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To: smith
Subject: Outline for Project Saturn presentation

CC:
Alternate fields (name: value)
X-Important ]: [URGENT, ]

|
]

[ OK ]] [Gancelj

Filling in alternate fields

You don’t want to add any alternate fields to this message, so you
leave them blank.

¢

N

Left click on OK to finish the header.

The dialog box disappears, and BBN/Slate displays a status
message at the bottom of the document editor telling you that it is
sending the message. If BBN/Slate is unable to send the message,
you will see an error message giving you the reason.

After sending the message, the system redisplays the message and
its attached mail header. This header contains the sender’s name,
the date, the recipient’s name, the subject line, and the names of
anyone receiving copies.
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Add Edit File Mail Print Glassify Document Editor Keycaps Exit

r'S é
From: "Chris Smith" {smith> =
Date: Wed, 16 May 90 14:36:01 EDT
4To: smith 3

Subject: OQutline for Project Saturn presentation
Cc:

v

Sal--

Project Saturn is really on a roll. I'm giving a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?

Thanks--
Chris Smith

Saturn: Up and Coming in a Growing Market
The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations, Easy to learn and to use, Saturn
should become a bestseller.
1. How does Project Saturn stack up against the competition?

A, Available on multiple workstations
B. Consistent look and feel

C. Easy to learn

ol

O O

77777 Buffer: standard-doc* File: [none] EZZ

Message with attached header

You can leave the message in the editor as you go on to compose
a new message.

Composing and sending a new message

Your outline is now out in the world, getting a review. You can
turn your attention to other parts of the presentation. After
thinking about the information you need in the presentation, you
decide that a colleague in Lisbon might have suitable facts and
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Composing a
new mail
message

figures. Since this colleague also has BBN/Slate, you send a
BBN/Slate message.

To send a message, you use the compose button to bring up a
standard mail message template, fill out the mail header, compose
the message, and send it.

To compose a new message, you use the compose button in the
document command pane.

Left click on the compose button in the document and folder
command pane.

| #BBN/Slate s FolderfiSsi NewalE1

1: 09 May 90 smith

Introduction

2 u 09 May 90 smith Presentation
3 U 09 May 90 smith SalesRegions
s s OiM a9 D kesmi thEsasssmsan O U Uine S ssonis s s

CEIrTER ( send ) (Ccancel (_done ) [+Getting Started
+demo
Folder: +New,

conf (_next )(_reply )( delete ) (folder ) (_save )

Using the compose button

The document editor is now split into two buffers A blank mail
message appears in the top buffer (called #compose), and the
blank buffer where you were working remains in the bottom.
After you send the message, the #compose buffer will disappear
and you will be returned to the buffer you were working in.
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Filling out a
mail header

EBBN/SlateiMultimediaiDocumentiEditol

Add Edit File Mail Print Classify Document Editor Keycaps Exit
To:
4|Subject: b
Cc:
[To:
[Subject:
[cc:
Alternate fields (name: value)
|: l
: |
[OIF |
EE T l
L |
= |
D
T
(5: I | |
l | |
54 L[ oK J] [ Cancel ]
Py
S I7 (=) el i = J x
your subject area too, can you give me some feedback on this outline?

EQle

0@ H ’
—

Buffer: standard-doc File: Outline.slt

L 0T

iddle button describes the itern under the pointer.

Header for new mail message

You fill out the mail header exactly as
this is an imaginary scenario, you send
instead of to a colleague.

® Move the pointer into the document

¢ Type in your own username in the T

In the real world, you would enter the

you did before. Because
the message to yourself
editor window.

o field. Press Return.

name of the real recipient.
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¢ Type in the subject line as shown below.

Data for Project Saturn

The header should look like this:

Your own username should appear here

/

¥

To: smith

Subject: Data for Project Saturn
CC:

Alternate fields (name: value)

[( ok ) ( cancel )

Filling out a mail header

You can leave the rest of the fields blank.
¢ Left click on OK to finish the header.

The dialog box disappears.
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Entering To enter the message, move the pointer inside the document editor
the message and begin typing. The text will automatically appear beneath the
mail header.

¢ Type in the message as it appears below:
Hi Jo, <RET>
I'm giving a presentation in a few days about how
Project Saturn stacks up against its competitors. Do
you have any data that I might be able to use? <RET>

Thanks for helping me out. <RET>

--Your name
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When you are finished, it should look like this:

##BBN/Slate;MultimediazDocumentsEditors
Add Edit File Mail Print Classify Document Editor Keycaps Exit

5

To: smith

:

Subject: Data for Project Saturn
c:

Hi Jo,

I'm giving a presentation in a few days about how Project Saturn stacks up
against its competitors, Do you have any data that | might be able to use?

Thanks for helping me out.

--Chris Smithy

O e S
i Buffer: #compose* 7
- ]
From: "Chris Smith" <{smith>
Date: Wed, 16 May 90 14:36:01 EDT
4To: smith b
Subject: Outline for Project Saturn presentation
Cc:
Sal--
Project Saturn is really on a roll. I'm giving a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline? -
F]
()rru : 1 W

Buffer: standard-doc File: Outline.slt |

heckpointed.

Typing in a mail message
When you are finished with the mail message, you can send it. .

Sending the To send the message, you use the Mail-Send-Send Message
message option on the menu bar.
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¢ Right hold on the Mail menu. Highlight the Send option,
then the Send Message option. Release.

Add Edit File

CIass:fy Document Editor Keycaps Exit

To: smith

Subject: Data for Prd

Cc: -
Hi Jo,

I'm glvmg a presentation in a few days about how Project Saturn stacks up
against its competitors, Do you have any data that | might be able to use?

Thanks for helping me out,

--Chris Smitty

Buffer: #compose*

From: "Chris Smith" {smith>

Date: Wed, 16 May 90 14:36:01 EDT

4{To: smith 3
Subject: Outline for Project Saturn presentation
Cc:

Sal--

Project Saturn is really on a roll. I'm giving a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?

(2 ah) 1

oD

<« HH[ o
Buffer: standard-doc File: Outline.slt
iddie button describes the selected menu item.

l

Sending a message

BBN/Slate sends the message and deletes the buffer from the
screen. If BBN/Slate is unable to send the message, you will see
an error message giving you the reason.
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Saving your
message

Before going on to the next section, save the comments that you
made to the outline.

Right hold on the File menu on the menu bar. Highlight
Write, then drag right to highlight Same File. Release.

Receiving Maii

During this session, you have sent two messages. Under normal
working conditions, you would have sent these to other people.
Because you are working with imaginary people, however, you
sent these messages to yourself.

Now you’ll take a look at these messages to see how you receive
mail from other people.

Depending on how fast your system is, you’ve probably already
received the first message that you sent earlier in this session.
Every so often, the document manager checks to see if you have
new mail. If you do, your system beeps, and BBN/Slate displays
a [New Mail] announcement at the top of the document
manager.

Look at your document manager to see if the announcement [New
Mail] appears, as it does in the next figure.
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New mail
announcement

Introduction
16 May 90 smith Presentation

16 May 90 smith SalesRegions

(_show ) (compose)(_send )(_cancel ) (_done ) [+Getting Started [2]

*ew s

Folder: +New)

(_conf ) (_next )( reply )( delete ) (foilder ) ( save )
New Mail announcement

If you see this announcement, you can look at the messages that
have just arrived.

Reading To read mail, you use the new mail button in the document
mail manager.

¢ Left click on the new mail button.
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sdéselected;

roduction
16 May 90 smith

1
2! Presentation
3 U 16 May 90 smith SalesRegions

+Getting Started [2]

O e ]

t #Newy
(foider ) (_save )

(_conf ) (Cnext )( reply )( delete )

Left click
here

Using the new mail button

BBN/Slate switches you to your mailbox and checks to see
whether you’ve received any new mail. If you have, the new mail
appears in the document editor, where you can read it. If you
haven’t received any mail yet, you can read it later.
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#% BBN/SlatesMultimediayDocument:Editon
Add Edit File Mail Print Classify Document Editor Keycaps Exit

From: Chris Smith
<smith@BBN.COM>
Date: Mon, 21 May 90 10:04.29 EDT
To: <smith@BBN.COM>
Subject: Outline for Project Saturn
presentation

X-MMDelivered-For:  smith

X-MMDelivered-By:  mmdeliver on spcinkbbn.com at
10014:22 05/21/90

Cc:

Sal--

Project Saturn is really on a roll. I'm giving a presentation on how
Saturn stacks up against the competition in just three days. Since this is
your subject area too, can you give me some feedback on this outline?

Thanks--
Chris Smith

Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Saturn
should become a bestseller

Buffer: 5_a10394 File: /home/spcsun7/ebritt/Slate/Mailbox/5_a10394

Reading new mail

At the same time, BBN/Slate displays the following dialog box.
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These users sent you rnultimedia mail and are not
on your list of default multimedia mail recipients.

You may add them to your list by confirming this dialog.

it
’

(C oK ) (TCancel)

Adding users to list of multimedia mail recipients

Whenever someone sends you multimedia mail for the first time,
BBN/Slate asks whether to add the name of the sender to your list
of multimedia mail recipients.

Because you sent yourself a multimedia message, the name in the
dialog box is your username. Add yourself to the list by left
clicking on the OK button.

¢ Left click on the OK button.

Now read your mail. Use the icons in the vertical scroll bar to
move through the document if you need to.

After you finish reading one piece of mail, you can read the next
piece by using the next button.

¢ Left click on the next button.
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Reading your
mail later

Saving your
messages

N2 o0 I
2; 21 May 90 smith Outline for Project Saturn presentation

(Cshow )  (compose)(__send )(_cancel ) (_done ) [+Getting Started [3]
+Mailbox
Folder: |
("conf ) ((next )( reply )( delete ) (folder ) ( save )
Left click
here

Displaying the next message

If you have another piece of mail, it appears in the document
editor. BBN/Slate leaves the original message in the editor if you
do not.

For various reason, you may read your mail later on in the tutorial
while you are working in another file. When you click on the
new mail button, your mail appears in the document editor and
the buffer you were working in disappears. After reading the
message, you can go back to your original buffer by using the
Editor menu on the menu bar.

To return to the buffer you were working in, right hold on the
Editor menu on the menu bar. Then drag down to highlight the
Buffer option and highlight the Switch To option. Highlight
the name of the original buffer and release.

You don’t have to do anything to save your mail messages. When
you finish with BBN/Slate and exit the system, they will remain in
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your mailbox. If you like, you can delete them from the document
manager or move them to another folder as you did in Chapter 2.
Make sure that you really want to delete any messages before
using the delete button in the document manager.

After reading your mail, leave the messages in the editor and go
on to the next chapter. If you want to exit from BBN/Slate and
take a break, leave the system as described at the end of Chapter
2.

What you've learned

In this chapter, you’ve made good progress toward getting your
presentation prepared. You:

* sent a document with comments attached to it

¢ composed and sent a new mail message

¢ read your mail

In the next chapter, you add spreadsheets and business graphs to
your presentation materials.
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5

Before you begin

Creating Spreadsheets and
Business Graphs

In your last session, you sent a mail message to a colleague in
Lisbon asking for financial information for your presentation. This
colleague has been experimenting with BBN/Slate as well and has
created a spreadsheet and bargraph for you from the data for
Project Saturn.

Assume that you’ve prepared a new document, called
Presentation, which follows the outline you created during
your first session and which contains the spreadsheet and bargraph
your colleague has sent you. During the company meeting, you
plan to use Presentation as a handout. Now you want to
change some values in the spreadsheet your colleague sent you and
also create another one.

During this session, you:

e open a new file

* cdit a spreadsheet and regenerate a bargarph
* create a new spreadsheet

¢ refine the new spreadsheet

* create a piechart from the new spreadsheet.

If you exited from BBN/Slate at the end of Chapter 4, re-enter the
software as shown at the beginning of Chapter 3.
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Opening a new file

At the end of the last chapter, you were in your Mailbox. Switch
to the folder +New and open the document called
Presentation, the document you will hand out during your

presentation.

¢ Using the left mouse button, double-click on the folder name

+New.

¢ Double-click on the name Presentation.

10 May 90 smith Outline

" SalesRegions

Double-click
here

(“conf ) (_next )(reply )( delete )

((show ) (compose)(__send )(_cancel ) (_done ) [+Getting Started B
o
Folder: +Newy

(folder ) ( save )

Opening a new file

The new document appears in the document editor.
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Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Project
Saturn is bound to become a bestseller.

Unlike many software packages, which are limited to one or two
machines, Project Saturn is available on most workstations, What's more,
the look and feel of Project Saturn is the same regardless of the machine
you use. Users on all workstations can learn the software quickly and
produce professional-quality documents immediately.

We expect high sales in Europe and in the United States. Because we
have little competition in Europe, we anticipate high sales during the
first year and increases of 30% and 60% during the second and third
years, respectively.

The spreadsheet and accompanying bargraph below highlight the current
sales projections for Saturn:

SALES PROJECTIONS (in millions of $)

REGION YEAR 1 YEAR 2 YEAR 3
Region 1
Great Britain 4,60 6.21 7.36
Ireland 2.30 3.10 3.68
Total 6.90 9.31 11.04

Region 2
Belgium

e Buffer: Presentation File: Presentation.sit

/home/srith/Slate /New /Presentation.sit read.

After opening a new file

M
)
=
=
@
3

a spreadsheet

The spreadsheet in this document contains formulas that calculate
projected sales. You have just found out that one of these
calculations is incorrect.

Changing a value The incorrect number is the expected number of sales in Great
Britain for Year 1, which is currently 4.60. You can find this
number in the fifth row of the second column.
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@ Left click on the number 4.60.

A

A B | c | D
1 . SALES PROJECTIONS (in millions of $) | . .
e T s STIONS. Mlon: I Loft click
3 JREGION VEAR 1 VEAR 2 VEAR SL—T" eft clic
amegion 1 | ] —— e here
4 _IRegion 1 SO IO
[ 2] Great Britain ag 621 788
Ireland 2.30 3.10 368

7 JTotal 6.90 5.31 1104 "

S

10

11
12

13

14

15

16 |Total 53.80 72,63 se.08| X

17

18

19
20

21

22

23

24

25

26

27

3

23

Selecting a cell

You have just clicked on cell BS. The cells in spreadsheets are
numbered by column (identified by letter) and row (identified by
number). Cell B5 is at the intersection of the second column (B)
and the fifth row (5).

Notice that cell BS is highlighted, or surrounded by a gray box,
meaning that you can edit it. Edit the cell by typing in the new

number, which is 20.6.

¢ Enter the number 20.6 into the cell. Press Return.
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Regenerating a
graph

After you press Return, the next cell down (B6) becomes
highlighted. Notice that several of the numbers in the spreadsheet
(those in cells CS5, DS, B7-D7, B31-D31) changed. These numbers
are based on formulas that depend on the value in BS. When you
changed the value in BS5, these numbers were recalculated
automatically.

A

A B | c | D
I SALES PROJECTIONS (in millions of $) | . .
2 : N ISR
3 |REGION YEAR 1 YEAR 2 YEAR 3|

L4 JRegion 1 e e e
5 Great Britain 20.60 27.81 32.96

5. Great Britain o  ..20.60 .....2781 . ...382%96/ .
6 Ireland 2,303 3.10 368 .
7 |Total 22,90 30.92 36.64|
8

poTECT T
9

prrrwremmg

After editing a cell

Your colleague generated the bargraph attached to this spreadsheet
using the old values. Although the spreadsheet editor recalculates
the values inside the spreadsheet automatically when you change a
number, it does not automatically regenerate the attached bargraph.

Before regenerating the graph, scroll down a little so that you can
see the bottom of the spreadsheet and the graph at the same time.
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& Left click on either set of arrows until the screen looks
something like this:

ediasDo ent: Editorsasknsiasssii il o :
Add Edit File Mail Print Document Editor Keycaps  Exit
e [ e Y
(25 Denmark 550 ..L.7A3 8.801 ... =
26 Finland Cvie] S| I 912 2
(o7 ) Norway e, 8.90| ... 12,020 . 14241 .
28 Sweden 10.20 18,77 16.32|
29 |Total 30.30 40.91 48.48|
sy 0+ V.
31|Total for all regions 107.00 144.45 171.20(
g2y 0 0 1 .
33 v
Sales Projections
By Year
Sales
200
Region 1
150
Region 2 =
100 :
Region 3
S0 | Region 4
Total
Year D
$
[ OR)

Buffer: Presentation* File: Presentation.slt

Scrolling down

To regenerate the graph, you use the Graph-Generate option
on the Sheet menu.

¢ Right hold inside the spreadsheet. Highlight the Graph option,
then the Generate option, then the Graphl option. Release.
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A= M O Ahgn ........................................... =
Numbers... B
Rulings...
=xa Calculate
28 Sweden Font...
2o jTotal Golumn Width... g
30 =
31 |Total for all rJ
32
33
Sales
200 0
Region 1
150
Region 2
100 :
Region 3
>0 | Region 4

s ; Buffer: Presentation* File: Presentation.sit
iddle button describes the selected menu item.

Generating a graph

The graph changes to reflect the new projections.
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Sales
200

Sales Projections
By Year

150

100

50

Region 1
Region 2
Region 3
Region 4

Total

After regenerating bargraph

Creating a spreadsheet

You decide to create another spreadsheet to show how much

revenue you expect Project Saturn to generate in the United States.

Adding a Left click on the arrows in the vertical scroll bar to move down

spreadsheet through the document. Place your cursor after the paragraph
ending "$67 million."

¢ Left click after the paragraph ending "$67 million."
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Add Edit File Mail Print Document Editor Keycaps  Exit
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100 B
Region 3
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At home, Saturn has more competition. The competition is fiercer in
the Western and Midwestern regions than in the Mississippi and Eastern
Seaboard regions.

Market Share -- USA
In the first year, we expect to have a market share ranging from 12% in

the Midwest region to 43% in the Mississippi region. Total sales should
approach $67 milliony

Key Project Goals

Project Saturn will help u\remain competitive in our current European
and Eastern United States songholds and move forward in the Western

Buffer: Preseftation* File: Presentation.sit

Left click here

After positioning the cursor

¢ Left hold on the Add menu on the menu bar. Drag down to

highlight the Spreadsheet option. Release.
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Header..

Document  Editor

Keycaps  Exit

)
Region 2

D

YEAR 2
Year

Region 3

Region 4

Total
YEAR 3

Adding a spreadsheet

A blank spreadsheet appears after the paragraph. Notice that this
time you used the left mouse button to select a menu from the
menu bar. Use whichever button is more comfortable to you.
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Add Edit File Mail Print Classify Document Editor Keycaps
Market Share ——- USA

Exit

0

In the first year, we expect to have a market share ranging from 12% in
the Midwest region to 43% in the Mississippi region. Total sales should
approach $67 million.

Key Project Goals

Project Saturn will help us remain competitive in our current European
and Eastern United States strongholds and move forward in the Western

7557 Buffer: Presentation* File: Presentation.sit

After adding a spreadsheet

Entering labels In this spreadsheet, you’ll show the total market, the expected
market share of Project Saturn, and the expected revenue. You
show these categories as labels along the top of the spreadsheet.
Labels are one of the three types of values you can use in
BBN/Slate spreadsheets. The other types of values are numbers
and formulas.

Begin the labels in the second column of the first row.

¢ Press TAB to move to the second column.
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You have moved to cell B1. Notice that cell B1 is highlighted.

Moving to cell B1

¢ Enter the following label into cell B1:

TOTAL MARKET
& Press Tab.

The label is overflowing into the next cell. Don’t worry about the
overflow now — you will enlarge the cells in a minute.
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“TOTAL MARKET : :

Entering a label

¢ Enter the following labels:
MARKET SHARE <TAB>

EXPECTED REVENUE

¢ Press Return.

When you are finished, the labels will run into each other as in the
following figure:
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Spreadsheet with overflowing labels

Enlarging cells To enlarge the cells, you drag on the column boundaries using the
middle mouse button.

¢ Select the spreadsheet by left clicking on it.

¢ Middle hold on the right boundary between the "B" and "C"
labels.

¢ Drag the boundary right until you have enough room for all of
the first label. Release.
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Middle hold here and drag right

/

A
A | B L¥c | D | E | F
1 ;TOTAL MARKMARKET SHAEXPECTED REVENUE & ...

Extending column boundaries

If you move the boundary too far to the right, you can move it
back again. Extend the boundaries of column C and D in the
same way.

Middle hold on the right boundary of the cell containing "C."
Drag right until you have enough room for the label. Release.

Middle hold on the right boundary of the cell containing "D."
Drag right until you have enough room for the label. Release.

The labels should now look something like the ones in the next
figure.
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C | D | E
‘MARKET SHARE EXPECTED REVENUE :

F P PP

After extending column boundaries

You can now continue to fill in the spreadsheet. First finish the
labels on the top.

¢ Left click in cell B2. Enter the following label:

(in millions of $)
¢ Press Tab.

The spreadsheet should look like the following one:
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Adding the second row of a label
Complete the other two labels in the same way.

Enter the following labels:
(Percentage) <TAB>

(in millions of §)
Press Return.

When you are finished, the labels should look like the ones in the
following figure.
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A | B 1 c | D | E

TR SO TOTAL MARKET MARKET SHARE EXPECTED REVENUE. ...
2 i(in millions of $) (Percentage) (in millions of $)
i

After completing the second row of labels

Whenever you finish entering a value into a cell, be sure to press
Tab or Return. Tab moves you to the next cell in the same row,
and Return takes you to the next cell in the same column. If you
left click on another cell before pressing Tab or Return, you will

change the value of the current cell.

Now fill in the side labels.

& Left click on cell A3. Enter the following label:

Western

¢ Press Return.
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;TOTAL MARKET 'MARKET SHARE EXPECTED REVENUE

Adding a side label
Add the other side labels as shown in the next figure.

> Enter the following labels:
Midwestern <RET>
Central <RET>

E. Seaboard <RET>

TOTAL

¢ Press Return.
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After adding side labels
Correcting If you make a mistake, you can correct it by editing the contents
mistakes of the cell.

First select the cell by left clicking on it. Then, left click after the
letter or number you want to edit, and press the Delete key to
delete the incorrect letters or numbers. Finally, type in the new
letters or numbers and press Return.

Entering numbers You can now begin entering the numerical data of the spreadsheet.
Begin in cell B3 and work your way down columns B and C.

¢ Left click on cell B3. Enter the following numbers:
100 <RET>
63 <RET>
49 <RET>

85

$ Press Return.
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A | B 1 G | D | E
TOTAL MARKET ‘MARKET SHARE PECTED HEVENUEg

Entering numerical data in column B

When you get to the end of column B, be sure to press Return
after the last cell. Then move to the top of column C and enter
the data for that column.

& Left click on cell C3. Enter the following numbers.
.21 <RET>
.12 <RET>
.43 <RET>

.35

© Press Return.
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TOTAL MARKET ‘MARKET SHARE EXPECTED REVENUE:

Entering numerical data in column C

Entering formulas The values in column D are calculations based on columns B and
C. You calculate these values using formulas.

First calculate the value of cell D3, then copy this formula into the
rest of column D.

¢

s

Left click in cell D3. Enter an equals sign:

<>

 Left click in cell B3.

When you click in the cell, a reference to it appears in cell D3.
As an alternative to clicking on cells, you can also type in the cell
references in either upper- or lowercase.
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Entering cell references

¢ Enter an asterisk:

¢ Left click in cell C3.

A | B | [& | D | E

Adding a formula

Creating Spreadsheets and Business Graphs 5-23



The formula begins with an equals sign (=), which tells the
spreadsheet to interpret the cell contents as a calculation. The
spreadsheet editor interprets the formula =B3*C3 as "the contents
of cell B3 multiplied by the contents of cell C3."

¢ Press Return.

After you press Return, the spreadsheet editor calculates the value
from the formula and puts the value into the cell.

A

A | B | C | D i E

After calculating a formula

You can use the formula you have already entered in cell D3 as a
basis for the formulas in the rest of column D. You just highlight
the cell containing the formula (in this case, D3) and drag down to
highlight all the cells in column D. Then select the Fi11l Down

option from the Edit menu.

¢ Left hold on cell D3. Drag down to highlight cells D4 through
D6. Release.
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Highlighting multiple cells

If you highlight too many cells, middle click to deselect the
region, and then begin again. Notice that the first cell you
highlighted, cell D3, still has the gray box around it. The other
cells are highlighted in black.

¢ Right hold inside the spreadsheet to display the Sheet menu.
Highlight the Edit option, then highlight the Fill Down
option. Release.

Creating Spreadsheets and Business Graphs 5-25



A

A I B | c I D J E

v

Duplicating a formula in a column

Values appear in cells D3 through D6.

A | | c | D L E
1 TOTAL MAHKET ‘MARKET SHARE EXPECTED REVENUE :
: (in millions of $)

Values calculated after duplicating a formula

There is one more value to calculate to complete this spreadsheet.
Cell D7 is the total of cells D3 through D6. You calculate this
number using a formula.
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¢ Left click on cell D7. Enter the following formula.

=SUM(D3:D6)

The spreadsheet editor interprets this formula as "the sum of the
values in cells D3 through D6." When you separate two values
with a colon, as you did with D3 and D6, the spreadsheet editor
calculates the values from those cells and all the cells in between.
As a short cut, you could have clicked on cell D3 and dragged to
cell D6 to enter the reference D3:D6.

A 1 B | c | D ] E
1 ‘TOTAL MARKET :MARKET SHARE EXPECTED REVENUE :

Entering a formula

Press Return to calculate the value.

& Press Return.
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After calculating the value

Refining the spreadsheet

After calculating the total expected revenue, you are finished with
the content of the spreadsheet. Now refine it by resizing it and by
adding lines, called rulings, to define the spreadsheet.

Resizing the Your spreadsheet takes up less cells than the spreadsheet editor

spreadsheet displays. You want to make it smaller, which you do by dragging
the handles at the edges of the spreadsheet. The following figure
shows the handles on the right side of the spreadsheet.
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Handles

Spreadsheet handles

Resize the spreadsheet by left holding on the bottom right handle
and dragging it.

¢ Left hold on the bottom right handle.
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Left hold here

¢ Drag up and to the left until the spreadsheet is about the size
of the one in the following figure.

When you drag on the handle, the cursor changes to a pointing
hand:

| B | c | D |
TOTAL MARKET MARKET SHARE EXPECTED REVENUE:

Dragging a spreadsheet handle
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Adding rulings

When you are finished, the spreadsheet should look like this:

A 1 B 1 [ | D |

1
e
2
3
TR
4
T
poerera
7
ey
8
oo
9

After resizing spreadsheet

Even though the spreadsheet looks smaller, you can still add data
to the spreadsheet until it reaches its maximum size of 2048 rows

by 256 columns.

When you left click outside the spreadsheet, you no longer see the
grid and row and column numbers that you saw while editing it.
To outline the rows and columns, you can add your own lines, or
rulings, using the spreadsheet editor. These rulings appear both on
your workstation screen and on paper.

To add rulings, you select the area you want to outline, select the
type of outline you want, and apply it.

First put a boxed ruling around the main part of the spreadsheet.

O Left drag from cell A3 to D7.

¢ Right hold inside the spreadsheet. Highlight the Rulings

option. Release.
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Galculate Db
Font... :
Column Width...

Selecting a region

The following dialog box appears.

Operation

® Add
QO Clear

Ruling Style

. D = il

Rulings window

You want to keep the dialog box up while you work.

¢ Left click on the Keep Up button.

Ruling Style Operation
BO=w| |9 Left oick
A I I here

) ) G

Keeping the ruling style dialog box up
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The dialog box moves outside the document editor window, out of
your way.

To surround the region you have highlighted with a box, use the
box ruling style.

@ Left click on the box ruling style.
@ Left click on the Add button.

¢ Left click on the Apply button.

Left click here first

Left click
here second

jSpreadshizetiBulingses
Ruling Style Ope
i ® Add
............... _ QO Clear
I W | i
(oply

Left click here last

Adding a ruling

After you click on the Apply button, the spreadsheet editor
applies the selected ruling to the highlighted area, as shown in the
following figure. To see the rulings, deselect the spreadsheet by
clicking outside the spreadsheet but still within the document
editor.

¢ Left click in another part of the document editor to see the
ruling.

Creating Spreadsheets and Business Graphs 5-33



TOTAL MARKET MARKET SHARE EXPECTED REVENUE

(in_millions of $) (Percentage) (in_millions of $)
Western 100 0.21 21
Midwestern 63 0.12 7.56
Central 49 0.43 21.07
E. Seaboard 85 0.35 29.75
TOTAL 79.38

After adding ruling

Now define the columns using the same square ruling style.
¢ Left click on the spreadsheet to select it.

¢ Left drag from cell B1 to cell B6.

C | D |

(DOﬁ\llG)U"lhIGJI\J_\

Selecting a column

Now apply the ruling. Because the square ruling style and Add
operation are already selected, you only need to click on the
Apply button.

¢ Left click on the Apply button,

When you left click outside the spreadsheet, it should look like
this:
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TOTAL MARKET |MARKET SHARE EXPECTED REVENUE

(in millions of $) l(Percentage) (in millions of $)
Western 100 0.21 21
Midwestern 63 0.12 7.56
Central 49 0.43 21.07
E. Seaboard 85 0.35 29.75
TOTAL 79.38

After applying ruling to column

Apply the same ruling style to columns C and D.

& Left drag from cell C1 to C6.

<

)
<>

Left click on the Apply button.
¢ Left drag from cell D1 to D6.
¢ Left click on the Apply button.

When you are finished, left click outside the spreadsheet. It
should look like the one in the next figure:

TOTAL MARKET |MARKET SHARE |[EXPECTED REVENUE

(in millions of $) [(Percentage) (in millions of $)
Western 100 0.21 21
Midwestern 63 0.12 7.56
Central 49 0.43 21.07
E. Seaboard 85 0.35 29.75
TOTAL 79.38

After adding rulings to columns

You need to add one more ruling to make the spreadsheet
complete.

¢ Left click on cell A6.
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Selecting a cell
Now choose the underscore ruling style.
¢ Left click on the underscore ruling style.

© Left click on the Apply button.

Left click
here first
‘ Operation
® Add
g s ey OC|ear
Capey )

Left click here last

Applying an underscore ruling

When you left click outside the spreadsheet area, your spreadsheet
should look like this:
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Correcting
mistakes

TOTAL MARKET |MARKET SHARE [EXPECTED REVENUE

(in millions of $) [(Percentage) (in_millions of $)
Western 100 0.21 21
Midwestern 63 0.12 7.56
Central 49 0.43 21.07
E. Seaboard 85 0.35 29.75
TOTAL 79.38

Spreadsheet complete with rulings

If your spreadsheet doesn’t look quite as it should, you
rulings the same way that you added them.

can remove

For instance, if you had an underscore ruling in cell B3, you could
remove it using the Clear button in the rulings dialog box.

/

Incorrect ruling

TOTAL MABKET |MARKET SHARE [EXPECTED REVENUE

(in_millions Af $) |[(Percentage) (in millions of $)
Western ¥ 100 0.21 21
Midwestern 63 0.12 7.56
Central 49 0.43 21.07
E. Seaboard 85 0.35 29.75
TOTAL 79.38

Incorrect ruling

To clear the incorrect ruling, first left click on cell B3. Next, left
click on the underscore ruling in the dialog box. Then, left click
on the Clear button and on the Apply button in the dialog box.
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Left click here first

#Spreadsheet:Rulings i il .
— — | Left click

Operation here
OA second
®TClear

Ruling Style

Left click here last

Removing rulings
When you click outside the spreadsheet, the ruling will be gone.

Taking down the You are finished with the rulings dialog box, so you can take it
rulings dialog box down.

¢ Left click on the Take Down button on the Spreadsheet
Rulings dialog box.

g Spreadsheet; Rulings diliienissim |

Ruling Style ‘ Operation
B0 E lgggr l Left click
I here

Coo)

Taking down the rulings dialog box

The dialog box disappears.
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Removing the Spreadsheets, by default, appear with outlines when you left click
outline outside them. To have the spreadsheet appear without the outline,
use the Change Attributes option on the Edit menu.

¢ Left click on the spreadsheet to select it.

A

B c D
TOTAL MARKET |MARKET SHARE |JEXPECTED REVENUE |

Western

E. Seaboard
TOTAL

(IiI-O.'l\JO)IU'I-bICDI\JA

Selecting the spreadsheet

Now select the Change Attributes option.

¢ Right hold on the Edit menu on the menu bar. Highlight
Change Attributes. Release.

iMultimediaiDocumentyEdito )
Add Bdsfied File  Mail  Print  Document  Editor  Keycaps  Exit
Market § Gut s
| Gopy , )
In the fird Glear ave a market share ranging from 12% in 0
the Midw¢ paste e Mississippi region. Total sales should
approach GeA htites &
A c D
1 TOTAL MARKET IMARKET SHARE |EXPECTED REVENUE
- .
LS qWestern
4 JMidwestern '
5 |Central 1l
b oS
6 |E. Seaboard
7 |JTOTAL
e et e e L
9
Changing attributes

When the dialog box appears, click on the cycle button beside
Outline. Then click on OK.
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¢ Left click on the cycle button beside Outline.

¢ Left click on OK.

Outline

Justification
Break Page

Keep with Next {¥No
Printed Size

) G
AN

M
{»None

OAS On Screen

—

\

Left click here last

Selecting no outline

When you left click outside the spreadsheet, it should look like

Left click here first

this:
TOTAL MARKET |MARKET SHARE [EXPECTED REVENUE
(in_millions of $) |(Percentage) (in_millions of $)
Western 100 0.21 21
Midwestern 63 0.12 7.56
Central 49 0.43 21.07
E. Seaboard 85 0.35 29.75
TOTAL 79.38

Spreadsheet without outline

Creating a piechart

Spreadsheets present information in rows and columns. Sometimes
analyzing data is easier if you can translate these rows and

columns into graphs.
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Creating a graph

You can create bargraphs, piecharts, and line graphs from
spreadsheets. Since piecharts are good for showing percentages,
you decide to make a piechart showing the percentage of revenue
contributed by each region.

To make a piechart, you select the Graph-Create option on the
Sheet menu and fill in the information that BBN/Slate needs to
create the graph.

¢ Right hold inside the spreadsheet. Highlight the Graph option,
then highlight the Create option. Release.

A
A Sheet D
i TO T Edit SHARE [EXPECTED REVENUE |
2 (in 1 Align ] (in_millions of $)
_3 WQStern ............. Numbers... 21
4_IMidwestern | Hulings", 3 R TP 7.56] S
_5 Central | .. Calculate OTTTRR-d0 ¥ PP 21.07|
6 |E. Seaboard Font... B 29.75
L - Golumn Width 79.38
?.‘.................4 ...... ol PRI Ll A L Toaaas | S R R R R R R
S
Muodify
Dalete
Follaw
Break Link
Creating a graph

The following dialog box appears.
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‘Name: graph?, ] E?fﬁegenerate Automatically
Type Title
Line 1:
Line 2:
Axis Labels
[X: AHY: J
Values to Plot
[XRange: A:A | Dataset £r1
Range: BB & Display lines
Labels: Eakahy Symbols
Legend:
Grid £ Both
X Axis Gontrol — Y Axis Control
Min: Min:
Max: Max:
Increment: Increment:
[[ oK ) (Gancel)

Dialog box for creating graphs

Defining the BBN/Slate uses the values you enter here to make the graph from
%aph type and your spreadsheet. Begin by defining the graph as a piechart and
itle

giving it a title.
¢ Left click on the button beside Pie.

¢ Left click in the Line 1 field. Enter the following:
Percentage of Revenue <RET>

By Region
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The dialog box should look like this:

Left click here

/ /

J
{Nam}é: graphy ‘Aﬂegenerate Automatically

Title X
Line 1: Percentage of Revenue
Line 2: By Region

Enter the title here

Axis Labels

[x: |[v:

Values to Plot
|XHange: AA ] Dataset {1
Range: B:B M Display lines
Labels: & Display Symbols
Legend:

Grid £ Both

X Axis Gontrol Y Axis Control
Min: Min:

Max: Max:
Increment: Increment:

[[ OK ] LCanceI]

Entering graph type and title
Defining values Continue to define the graph by telling BBN/Slate which values to
to graph use for the piechart. Since you are showing the percentage of
revenue by region, you graph columns A (region) and D (revenue)
as the XRange. First, delete the default XRange of A:A.
¢ Left click after A:A in the XRange field.

¢ Press the Backspace key three times to delete A:A.
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Left click here and

delete A:A
]
[Name: graph] | & Regenerate Automatically
Type Titl

Line 1: Percentage of Revenue
Lipe 2: By Region

Axis Labels I
l
|

'X: ”Y:

Values to Plot
|XHange: A:AZ I Dataset {1
Range: BB & Display lines
Labels: & Display Symbols
Legend:

Grid £»Both

X Axis Gontrol —— Y Axis Control
Min: Min:

Max: Max:
Increment: Increment:

[ ok ) (GCancel)

Deleting the existing XRange

In a piechart, BBN/Slate uses the XRange to define the slices of
the pie. You want the four portions to reflect the four regions, so
you define the XRange as A3:A6. (Remember that cells A3
through A6 contain the labels Western, Midwestern, Central, and
E. Seaboard.)

¢ Enter the following:

A3:A6 <RET>

The cursor moves to the next field.
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|Name: graphi

Type Title

Line 1: Percentage of Revenue
Line 2: By Revenue

Axis Labels

[X:

HY:

Values to Plot

|XHange: A3:AG

| Dataset {r1

Range: B:B, @‘Display lines
Labels: & Display Symbols
Legend:

Grid £ Both

X Axis Gontrol Y Axis Gontrol

Min: Min:

Max: Max:

Increment: Increment:

] Qfﬂegenerate Automatically

[ ok ]] ( Gancel )

Moving to the next field

You have moved into the Range field. BBN/Slate uses the data
in the Range field to calculate the proportions of the pie. You
want to base the proportions on actual revenue as shown in cells

D3 through D6.
¢ Press the Backspace key three times to delete B:B.

¢ Enter the following:

D3:D6
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IName: graph1

Type Title

Line 1: Percentage of Revenue
Line 2: By Revenue

Axis Labels

[X:

HY:

Values to Plot

IVXFIange: A3:AB

} Dataset 21

Range: D3:D§ EZfDisplay lines
Labels: EZ'Display Symbols
Legend:
Grid > Both
X Axis Gontrol Y Axis Gontrol
Min: Min:
Max: Max:
Increment: Increment:

I @'Hegenerate Automatically

[[ OK ]] [Cancel]

Entering the Range values

This is all the information BBN/Slate needs to generate the
piechart.

¢ Left click on the OK button.
When you select OK, BBN/Slate generates the piechart and places

it below your spreadsheet. It should look like the one in the
following figure:
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Spreadsheet and piechart

The piechart you have created is linked to the spreadsheet until
you explicitly break the link between them. When you break the
link, you can no longer alter the graph from the Sheet menu.

The piechart is a graphic that you can edit using the BBN/Slate
graphics editor, explained in the next chapter. If you make any
changes to the piechart, these changes are not reflected in the
spreadsheet.
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Saving your Save your presentation so that you’ll be ready to work in the next
document chapter. In addition to saving by selecting options from the menu
bar, you can also use the keyboard.

¢ Hold down the Control key.
¢ Press X, then S.

BBN/Slate saves your document. For more information on using
other keyboard shortcuts, see the Customizing Manual.

If you want to exit BBN/Slate and rest before going on to the next
chapter, follow the instructions at the end of Chapter 2.

What you’ve learned

In this chapter, you have:

* changed a value in a spreadsheet
* regenerated a bargraph
» created and refined a spreadsheet

» created a piechart based on a spreadsheet

As well as learning specifically about spreadsheets, you are also
becoming acquainted with BBN/Slate’s multimedia format. This
format lets you move to and from the media types most
appropriate to the information you want to convey.

In this next chapter, you add graphics and images to your
presentation.
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Creating Graphics and
Imaoces

Your presentation materials are coming along nicely. You have
good-looking text that will work well as a handout, and you have
a couple of spreadsheets and business graphs that reflect how
Project Saturn stands up to the competition.

You have found an image that will work well as a logo for the
project — a scanned image of Saturn. In this chapter, you add
this to the presentation materials.

You’ll also add to the materials a map that one of your colleagues
sent you through multimedia mail. This map shows the expected
sales of Project Saturn in the United States. After adding the map,
you edit it by adding a key that names each region.

During this session, you work with images and graphics. An
image is a black and white representation of a photograph,
drawing, or screen display. You can import images from the file
system, capture them from your workstation screen, or create them
yourself using the BBN/Slate image editor.

Graphics are drawings composed of lines, geometric figures, text,
and textures. You can also include images within graphics.

How are images and graphics different? When creating graphics,
you can edit objects (such as text, lines, or shapes) separately. By
contrast, you work with an image as a single unit. For instance, if
you add a line to an image, it becomes an integral part of the
image. You can edit the line only by also editing the part of the
image surrounding it.
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In this session, you:

* add an image from the file system
* add a graphic from another BBN/Slate document
* edit the graphic

Before you begin Make sure that the document Presentation still appears in the
document editor. If you took a break after the last chapter and
exited the software, re-enter before beginning this chapter. Then
open the +New folder and the Presentation document.

¥

Adding images from ihe file sysiem

(X

You can import into a BBN/Slate document images that exist in
your file system. You may have scanned these images in yourself,
or you may have received them from other people or created them
in other software packages.

Adding the The image of Saturn is in the +Getting Started folder. You

image can move to this folder without disturbing the document currently
in the document editor by double-clicking on its name in the folder
list.

¢ Using the left mouse button, double-click on the folder name
+Getting Started.

Your presentation is still in the document editor, but your current

folder is +Getting Started. Notice that the document listing
doesn’t contain anything named Saturn. This is because the list
contains only BBN/Slate documents, and the image you are adding
is not yet in BBN/Slate format.

Before you add the image, decide where to place it in the
Presentation document and place the cursor there.
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¢ Move to the beginning of the document. Left click at the

beginning of the first paragraph.

To add the image, you use the Image-BBN/Slate Bitmap
option on the Add menu.

¢ Right hold on the Add menu on the menu bar. Highlight the
Image option. Highlight the BBN/Slate Bitmap option.
Release.

ﬁ Edit File Mail Print Document Editor Keycaps Exit

Text
Graphms _

ing in a Growing Market 0

uct line, Project Saturn is a software
ns. Easy to learn and to use, Project

P ges, which are limited to one or two
Saturn is available on most workstations. What's more,
the look and feel of Project Saturn is the same regardless of the machine
you use. Users on all workstations can learn the software quickly and
produce professional-quality documents immediately.

We expect high sales in Europe and in the United States, Because we
have little competition in Europe, we anticipate high sales during the
first year and increases of 30% and 60% during the second and third
years, Trespectively.

The spreadsheet and accompanying bargraph below highlight the current
sales projections for Saturn:

iddle button describes the selected menu item,

SALES PROJECTIONS (in millions of $)

REGION YEAR 1 YEAR 2 YEAR 3
Region 1

Great Britain 20.60 27.81 32.96

Ireland 2,30 3.10 3.68
Total 22.90 30.92 36.64
Region 2

Belgium

Adding an image from a file
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A dialog box appears. You enter the name of the file containing
the image, which in this case is Saturn.bit.

¢ Type Saturn.bit in the dialog box. Left click on OK.

Image from file:

I Saturn.bit I

List [[ oK ] ( cancel |

Specifying the file containing the image

The Saturn image appears at the beginning of your document.
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eiMultimediagDocumentiEdi i s e G i

Add Edit File Mail Print Document Editor Keycaps  Exit

Saturn: Up and Coming in a Growing Market [5

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Project
Saturn is bound to become a bestseller.

Unlike many software packages, which are limited to one or two
machines, Project Saturn is available on most workstations. What's more,
the look and feel of Project Saturn is the same regardless of the machine
you use. Users on all workstations can learn the software quickly and
produce professional-quality documents immediately.

Buffer: Presentation* File: Zhome/smith/Slate/New /Presentation.sit

Document with image added from file

Changing To center the image between the margins and remove the border
image from the outside, you select the Change Attributes option
attributes from the Edit menu.

Before changing the attributes, make sure the image is selected.
You can tell if an image is selected because of the handles that
appear around the outside. If you don’t see these handles, left
click on the image to select it.
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} «—— Handles

Handles on an image

¢ Right hold on the Edit menu on the menu bar. Drag down
to highlight the Change Attributes option. Release.

$i BBN/SlatesMultimediagDocumentiEditoratiinianinasn s e

Add F{&iic | File Mail Print Document Editor Keycaps Exit
Gut - =
Copy | I ) &
Clear émlng in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations, Easy to learn and to use, Project
Saturn is bound to become a bestseller.

Changing image attributes

6-6 BBN/Slate Getting Started



You see a dialog box that lets you change the way the image
looks on your screen or on the printed page. To change the outline
and the justification of the image, you use the cycle button beside
the words Outline and Justification.

¢ Left click on the cycle button beside Outline.

¢ Left click twice on the cycle button beside Justification.

Left click on OK.

Left click here

Left click here
Outline W
Justification LéCenter

twice

Break Page £ None

Keep with Next £ No

Float £ Don't Float
Printed Size {x As On Screen

Classification  /» <none>

[( 0K j] LC&ncel]

Changing the image outline and justification

When you clicked on the cycle buttons, you changed the attributes
of the image. As you probably noticed when you clicked on the
Justification switch, this attribute has several possible values.

After you click on OK, the image moves to the middle of the
screen. If you click outside the image, the box around Saturn
disappears.

¢ Left click outside the image area.
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BN/Slate:iMultimediaj

Add Edit File Mail Print Document Editor Keycaps  Exit

Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Saturn is a software
package that runs on most workstations. Easy to learn and to use, Project
Saturn is bound to become a bestsellery

Unlike many software packages, which are limited to one or two
machines, Project Saturn is available on most workstations. What's more,
the look and feel of Project Saturn is the same regardless of the machine
you use. Users on all workstations can learn the software quickly and
produce professional-quality documents immediately.

Image after changing attributes

Adding a graphic from a BBN/Slate document

In addition to adding images from the file system, you can paste
images, or in this case graphics, from other BBN/Slate documents.
One of your colleagues has sent you a mail message containing a
map that shows sales areas in the United States. When you
received this map, you stored it in a separate file. You decide to
copy this graphic from the file and paste it into your presentation.
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To copy this map, you open up the file, copy the graphic, and
paste it into your presentation.

Opening two Open the document containing the map and show it in the
documents at document editor.
once

¢ Double-click on the name +New.

Left click once on the name SalesRegions.

¢ Right hold on the show button. Highlight the Show
Document with Previous Document option. Release.

W 0 5 a0y O O4s il thisenie
09 May 90 smith

Show Document

ik 2 etting Started
ailbox

Folder: +Getting Started

(Cconf ) ( P\c‘:xt ) reply )( delete ) ((foider ) (_save )

\ Right hold here

Opening two documents at once

When you open multiple files, BBN/Slate keeps them in separate
buffers. Picture the buffers in layers in the document editor, with
the document you most recently opened on top. You can see only
the buffer on top.
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BBN/Slate displays the map in the document editor. Your
Presentation file is still in the editor, but in a layer beneath
the SalesRegions buffer.

Add Edit File Mail Print Classify Document Editor Keycaps Exit

£ I

File containing graphic

Copying a To get the graphic from the first file into your presentation, you
graphic copy it, go back to the presentation file, and paste it.

¢ Left click inside the graphic to select it.
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Graphics, like images and spreadsheets, have handles. When you
have selected a graphic, you can see its handles around the outside

border.

Graphic handles

T

Selected graphic with handles

After you select the graphic, you copy it by selecting Copy from
the Edit menu on the menu bar.

¢ Right hold on the Edit menu. Highlight the Copy option.
Release.
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vy S

i BBN/SlatexMultimediaiDocument: Editoriissisisnaiiiaiiit b |
Add f[Zii] File Mail Print Classify Document Editor Keycaps Exit "

a

-1 Glear
-| Paste

SRR

-| Ghange Attributes

Copying a selected graphic

Pasting a graphic

Now that you’ve copied the graphic, you need to move to the
Presentation file. Because you already have this file open,

you simply move between buffers.

¢ Right hold on the Editor menu. Highlight the Buffer
option, then highlight the Switch To option. Select

Presentation.

Release.
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Mail Print  Document

Window| Delete <
Director] List

ey

it

ER RN
e s e e
TASrrre.
AT

A

o,

iddle button describes the selected rnenu item.

Switching to another file

The Presentation buffer now moves to the front of the
document editor, and the SalesRegions buffer moves further
back. You want to place the map of sales regions at the end of the
paragraph ending "Eastern Seaboard regions." First move there
using the vertical scroll bar.

¢ Left click after the paragraph ending "Eastern Seaboard
regions."
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DD /Slates Multimedia§ DocumentiE ditor S AoH
Add Edit File Mail Print Document Editor Keycaps  Exit

By Tear 3
Sales B
200
Region 1
150
Region 2
100
Region 3
>0 1 Region 4
|: .. ; I Total
YEAR 1 YEAR 2 YEAR 3
Year

At home, Saturn has more competition. The competition is fiercer in
the Western and Midwestern regions than in the Mississippi and Eastern
Seaboard regionsy

Market Share -{ USA

In the first year, we\ expect to have a market share ranging from 12% in
the Midwest region o 43% in the Mississippi region. Total sales should
approach $67 millio

E?

o . L4
File: /home/smith/Slate/New /Presentation.sit

\ Left click here

Moving to the end of the document

Now paste the map by selecting Paste from the Edit menu on
the menu bar.

¢ Right hold on the Edit menu. Drag down to select Paste.
Release.
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Mail Print Document Editor Keycaps

Exit

T ear

Gopy
Cliar

Region 1

150
Region 2
100 :
Region 3
0 Region 4
- - — Total
YEAR 1 YEAR 2 YEAR 3
Year

At home, Saturn has more competition. The competition is fiercer in
the Western and Midwestern regions than in the Mississippi and Eastern
Seaboard regionsy

Market Share -—- USA

In the first year, we expect to have a market share ranging from 12% in
the Midwest region to 43% in the Mississippi region. Total sales should
approach $67 million.

Buffer: Presentation* File: /home/smith/Slate /New /Presentation.sit )

iddle button describes the selected menu itermn.

Pasting into a file

The map now appears in your presentation.

Editing a graphic

The map of the United States that you just pasted into your

document needs a key and a title. You can add them easily using

the graphics editor.
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Before you begin, resize the graphic so that it fits easily between
your margins. Then create the key by drawing and filling
rectangles that correspond to the sales regions on the map and
adding explanatory labels. Finally, add a title to the entire graphic.

Resizing a To resize a graphic, you use the Edit-Scale option on the
graphic Graphics menu.

¢ Left click on the map to select it.

¢ Right hold to display the Graphics menu. Highlight the
Scale option. Release.
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Add Edit File Mail Print Document Editor Keycaps  Exit

HG[o

Palette... S

Style = DI

Placement ad: MRS
i CUT

1 Preferences | Paste

Groug Copy

Ungroup Clear

Select All Duplicate
Unitla sScale b
Reshape Change Arrows i
1 Move Bovod Goroses = HIMTHITT

Select Smooth or Unsmooth

Buffer: Presentation* File: /home/smith/Slate/New /Presentation.slt
iddle button describes the selected menu itern.

Selecting the entire graphic

A dialog box appears. Scale the figure to 60% of its original size.
¢ Left click on the Size Only button.

Type in .6 in the scale factor field:

.6 <RETURN>
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Left click here Type in .6 here

/ /
Type of Scaling ‘ /
l Size and Position | |Scale factor: .7 |

Size Only

[ ok J (Cancel)

Scaling a graphic

In many dialog boxes, pressing Return is the same as clicking on
the OK button. After you press Return, BBN/Slate resizes the map
and leaves the border the same size.
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;BBN/Slate;MultimediaiDocumentsEditor
Add Edit File Mail Print Document

Editor Keycaps  Exit
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Buffer: Presentation* File: Zhome/smith/Slate/New /Presentation.sit

After resizing the graphic

You can resize the border by dragging on a corner handle. First
use the scroll bar to move down and to the right until you see the
bottom corner handle, as in the following figure.
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Exit

Lo o

7 Buffer: Presentation* File: /home/smith/Slate/New /Presentation.sit [

Moving to the bottom corner

Now drag the handle up and to the left. Leave some room
underneath the map so that you can add the key at the bottom.

¢ Left hold on the bottom right handle.

¢ Drag up and left until the graphic looks like the one in the
following figure.
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Drawing an
object

46 BBN/SlateiMultime diadDocumentEditor iSRRI
Mail Print Document Editor Keycaps Exit

HOZ[»

Add _ Edit
I

Buffer: Presentation* File: /home/smith/Slate/New /Presentation.slit

Resizing the graphics border

After resizing the border, move up and to the left until you see the
entire map in the document editor.

To draw a rectangle, you use the rectangle tool on the graphics
palette. Bring up the graphics palette by selecting Palette

from the Graphics menu.

¢ Right hold inside the graphic. Highlight Palette. Release.

Creating Graphics and Images 6-21




Placement
. | Edit
T Preferences
Groop
Ungroup
Select All
Unddo
Reshape
Move
Select

Selecting the graphics palette

The graphics palette appears overlaid on the graphic.
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The graphics palette

You want to keep the palette up while you work, so you click on
the Keep Up button.

¢ Left click on the Keep Up button.

The palette moves out of your way. To draw, you select items
from the palette and then use them within the graphics box.

Start the key by creating a rectangle.

¢ Left click on the rectangle icon on the graphics palette.
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Selecting the rectangle icon

The icon dims to show that you can draw a rectangle within the
graphics region. When you move into the graphics region, the
cursor changes to a pencil.

¢ Left hold inside the graphics region. Drag right and down
until you create a rectangle about the size of the one in the
next figure. Release.
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Drawing a rectangle

Notice that the graphics editor automatically lines the rectangle up
with the dotted lines on the background of the graphic, called the
graphics grid. With grid mode turned on, you can easily create
and place the rectangle accurately. To have more control over
where you place objects, you can turn grid mode off.

Duplicating an Because the map contains four regions, you create four rectangles
object for the key. Instead of drawing four separate boxes, you use the
Duplicate option on the Graphics-Edit menu.

¢ Left click on the rectangle to select it.
¢ Right hold anywhere inside the graphic to display the

Graphics menu. Highlight Edit, and then drag right to
highlight buplicate. Release.
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Duplicating the rectangle

The duplicated rectangle appears on top of the original rectangle.
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Duplicated rectangle

Create the other two rectangles in the same way.
@ Left click on either rectangle to select it.

€ Right hold inside the graphic. Highlight Edit, and then
highlight Duplicate. Release.
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Duplicating the rectangle again

To create the final rectangle, select the Duplicate option once
more.

Right hold inside the graphic. Highlight Edit, and then
highlight Duplicate. Release.

You have created four rectangles.
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Duplicated rectangles

Positioning After creating the four rectangles that will make up the map key,
objects you position them. With grid mode turned on, positioning objects
is easy.

¢ Left hold in the middle of the second rectangle. Move the
rectangle until it is lined up roughly as shown in the following
figure.
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Positioning the rectangles

When you left click on an object away from any of the graphics
handles, you see an upright hand on top of the object. This hand
is your signal that when you move the cursor, you will move the
object. If you click on any of the graphics handles, you see a
pointing hand. If you move the cursor when you see the pointing
hand, you will stretch the object instead of moving it.

P

Left click Left click on a
inside an object handle to stretch
to move it an object

Moving vs. stretching an object

6-30 BBN/Slate Getting Started



Now position the other third and fourth rectangles using the same
method.

¢ Left hold inside each of the third and fourth rectangles. Drag
them into the positions shown in the following figure.

e
- I‘IK

Aligning rectangles

Because you have grid mode turned on, the rectangles align easily
with each other.

Filling in objects The next step in making the map key is to fill in each rectangle
with the pattern of its corresponding region on the map. To fill in
objects, you select the object, then use the fill icons on the
graphics palette.

¢ Left click on the first rectangle to select it.
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¢ Left click on the fill pattern in the graphics palette that
matches the western-most region on the map.

%%@@ | Leftclick on

this fill pattern

Selecting a fill pattern

The pattern appears in the selected rectangle.

Filled rectangle

Fill in the other three rectangles in the same way.
¢ Left click on the second rectangle to select it.

¢ Left click on the fill pattern in the graphics palette as shown
in the following figure.

6-32 BBN/Slate Getting Started



~_ Left click on
this fill pattern

Selecting a second fill pattern

This fill pattern appears in the second rectangle.

CEE

T

b
]

Filling the second rectangle

Fill the remaining two rectangles with the patterns shown in the
next figure.

Select each of the remaining rectangles in turn.

¢ Fill each rectangle in turn.
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Filling the third and fourth rectangles

When you are finished, the rectangles should look like the ones in
the figure below.

Filled rectangles
Adding text to a To finish the key, you add explanatory text beside the rectangles to
graphic indicate the region each pattern refers to.

& Left click on the text icon on the graphics palette.
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Selecting the text icon

The text icon dims to show that you can add text to the graphic.

¢ Position the cursor beside the first rectangle and left click.

< Enter the text as shown in the following figure.
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Entering text

Instead of pressing Return at the end of the line of text, you select
the text icon again and begin a separate block of text for the next
label. By creating each label separately, you can move and edit
them separately.

Create the next three labels by first selecting the text icon and then
entering the text.

¢ Left click on the text icon on the graphics palette.
¢ Left click beside the second rectangle.

¢ Enter the following text:

Midwestern Region
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Continue to label the rectangles.
& Left click on the text icon.
Left click beside the third rectangle.

¢ Enter the following text:

Central Region

Add the final label.

© Left click on the text icon on the graphics palette.
© Left click beside the last rectangle.

¢ Enter the following text:

Eastern Seaboard Region

When you are finished, the graphic should look like the following
figure:
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Eastern Seaboard Regiory .

Key complete with labels

Adding a title to a The sales regions map is almost complete. To finish it, you add a
graphic title at the top, change the title to a larger point size, and make it
bold.

If you don’t have enough room at the top of the graphic, drag one
of the corner handles up to make room.

¢ Left click on the text icon on the graphics palette.
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Selecting the text icon
The icon dims to show that you can now add text to the graphic.
¢ Move the pointer to the top of the graphic. Left click.

¢ Enter the title as shown in the next figure.
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Enter the title here

| -

Project Saturn Sales Regiong .

Western Region.

Adding a title

Notice that the title is in the same type as the text of the key
labels. Because you want the title to stand out, you change the
point size.

¢ Right hold to bring up the Graphics menu. Highlight the
Style option, and then highlight Font. Release.
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Changing the font

A dialog box listing the current type family, face, and size appears.
You want to change the style to 14 point Helvetica bold.

Font
Family Ly helvetica
Face /v Normal
Size [»10pt

[[ 0K ]] [Cancel]

Current font

¢ Left click on the Face cycle button until you see the word
Bold appear.

¢ Left click on the Size cycle button until you see 14 pt
appear.
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Font
Family s helvetica

Face Id
Size Q%\‘
—=——_ ] Leftclick on these
[[ oK ]] [ Cancelj cycle buttons

Selecting a new typeface and type size

& Left click on the OK button.

The title now appears in an 14 point bold font.

A

. Pl;ojeét'S'aiufn'S'al'es' F'te'gibn's:

Western Region.

Title in 14 point bold font

Taking down the Now that you are finished editing the graphic, take down the
graphics palette graphics palette.

@ Left click on the Take Down button on the graphics palette.

The palette disappears.
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Saving Now save your presentation.

¢ Right hold on the File menu on the menu bar. Drag down
to highlight the Write option. Highlight the Same File
option. Release.

You are now ready to move on to the next chapter. To take a
break beforehand, exit from the software as described at the end of
Chapter 2.

What you’ve learned

This chapter taught you how to:

* import an image from the file system
* cut and paste a graphic from another BBN/Slate document

* use the graphics tools by editing a graphic

You also learned the difference between an image and a graphic.
In the next chapter, you will print the document that you’ve
created during the last four chapters.
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Before you begin

Printing

BBN/Slate makes it easy for you to use very little paper in your
everyday work. You can send memos through electronic mail,
distribute company newsletters on-line, and review someone else’s
documents through conferencing. However, you’ll also want to
print out many of your documents.

With BBN/Slate, you can preview how your document will look
when printed, add page numbers and dates, specify headers and
footers for right and left pages, and much more.

Your presentation on Project Saturn is tomorrow. You want to
print out your document to hand out during the presentation.
During this work session, you:

¢ make sure you are set up to print

* add a footer to your document

* preview your document

* print your document

Before beginning this chapter, you should be in the document
Presentation, in the +New folder. If you exited BBN/Slate at
the end of the last chapter, re-enter the software first.

Setting up to print

BBN/Slate prints to PostScript®-capable laser printers. Before you
begin working through this chapter, make sure that a PostScript-
capable printer is available from your workstation.
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Also make sure that your system administrator has set up your
printing commands correctly.

Adding a footer to your document

You decide to add a footer to your document which contains the
title, date, and page numbers. This information will help the
audience find what they are looking for during the presentation and
will help them file it away for future reference.

Adding a footer When you add footers, you don’t see them until you preview or
print out the document. To add a footer, you select the
Preview/Print option from the Print menu and fill in the
information in the dialog box.
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F Buffer: Presentation File: Presentation.sit
iddle button describes the selected menu item,

Selecting the Preview/Print option from the Print menu

¢ Right hold on the Print menu on the menu bar. Highlight
the Preview/Print option. Release.

The Preview/Print dialog box appears.
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Page Dimensions Margins
Width: 8.5i Top: 750 Left: .75i
Height: 11i Bottom: .75i Right: .75i

Orientation Page Numbers
@® Portrait Start page number: 1
O Landscape Unnumbered title pages: 0

[J Generate Table of Contents M Print Headers

[J odd-Even Page Layout

Header
Both Pages:

Footer
Both Pages:

Columns Header/Footer Font
Colurnns per page: 1 Family ¥ helvetica
Gutter: .5i Face [ Normal

Size {»10pt

Spooling
@ To printer (O To Previewer
O To File O setup Only

Spooler: Ipr %s [L OK ]J [Cancelj

Preview/Print dialog box

BBN/Slate lets you put the same footer on all pages, or different
footers on odd and even pages. For different footers, you tell
BBN/Slate to use an odd-even page layout and then enter each
footer into the dialog box.

You decide to have the same footer on both pages.

¢ Left click in the Footer field. Enter the following text:

Project Saturn~@date~@1
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The Footer field should look like this:

Enter the
footer
information
here /
Page Dimensions Margins /
Width: 8.5i Top: 750 Leftf .75i
Height: 11i _l | Bottom: .75i Rig¢: 750
Orientation Page Numbers [
@ Portrait Start page nurnber: 1
QO Landscape Unnumbered title pag#z 0

[0 Generate Table of Contents MPrint H¢aders

[0 odd-Even Page Layout

Header
Both Pages: /
Footer ‘,
Both Pages: Project Saturn~@date~@1

Columns Header/Footer Font
Columns per page: 1 Family £ helvetica
Gutter: .5i Face »Normal

. Size fx10pt

Spooling

@ To Printer O To Previewer
O To File QO setup Only

Spooler: Ipr s [( oK j] (Cancelj

Creating a footer

You just added information for the page number, current date, as
well as the name of the document. When BBN/Slate prints the
document, it will print the current page number in place of the @1
and the current date in place of the @date. The tilde (~)
characters separate the footer into the left, center and right position
on the page.

When you are finished typing in the footers, you can use the same
dialog box to preview your document.
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Sending a
document to the
previewer

Previewing your document

Previewing a document lets you see how it will look when printed.
Since what you see in the document editor is slightly different
from the printed output, you can preview it first to make sure it
will look as you expect.

Some elements of your document, such as headers and footers,
do not appear until you preview or print the document. In your
printed document, lines and pages may break differently, and
figures may may appear in a different position than on screen.
If you use the previewer first, you can make any necessary
adjustments before sending the document to the printer.

To preview a document, you select the Preview/Print option
from the menu bar, as you have already done. Or you can send it
directly to the previewer by using the Preview option from the
same menu.

Since you have already selected the Preview/Print option, you
are ready to send the document to the previewer.

¢ Left click on the button beside the To Previewer option.

¢ Left click on OK.
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Page Dimensions

Margins
Width: 8.5i Top: 75i Left: .75i
Height: 11i Bottom: .75i Right: .75i
Orientation Page Numbers
@ Portrait Start page number: 1
QO Landscape Unnumbered title pages: 0

[ odd-Even Page Layout
Header

Both Pages:

[J Generate Table of Contents

& Print Headers

Footer

Columns

Both Pages: Project Saturn~@date~@1

Columns per page: 1
Gutter: .5i

Header /Footer Font
Family {x helvetica

Face e Normal
Size /10 pt
Spooling ~ P
QO To Printer To Previewer
O To File Setup Only
[ ok ) (cancel)
: /

Left click here

Sending a document to the previewer

In a few seconds, the previewer window appears.
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#BBN/SlatePage:Previewer:ziPageisl«of 5 8

Saturn: Up and Coming in a Growing Market

The most recent addition to our product line, Project Setum is a software packsge that runs on
most workstations Easy t learn and ® use, Project Setum is bound t become a bestseller.

Unlike many softwere packeges, which ere limited to one or two mechines, Project Setum is
availeble on most workstations. What's more, the look end feel of Project Satumn is the same
regerdless of the machine you use. Users on all workstetions cen leam the software quickly and
produce prof essionel quality documents immedietely.

ProjectSatum FriMay 11, 1950 1
~ f a8
Footer
Previewer window
Moving through There are several ways of paging through the document in the
the document previewer. You can use the scroll bars on the right side of the

window, the space bar, or the Previewer menu.
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¢ Right hold anywhere within the previewer window to bring up
the previewer menu. Highlight the Next Page option.

Release.

#BBN/Slate:Page:Previewen:# Pageiilsofis b iissiigismleiig

Satarn: Up and Coming in a Growing Market

The most recent addition t our product lne, Project Setumn is & software package thet runs on
most workstations Easy @ lesrn end wfuse, Project Sarum is bound W become a bestseller.

Unlike many software packsges, which fare limited to one or two machines, Project Setum is
available on most workstations. Whats more, the look and feel of Project Saturn is the same
regardless of the machine you use Ufers on all workstations cen leam the softwere quickly and
produce professional-quality documegts immediarely.

/

Using the previewer window

Previewer menu

You now see the second page of your document.
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1sBBN/Slate:Page:Previewer:i Pages2;ofs b sinawsiibiisms eitisish e ﬁ SR
We expect high seles in Ewope and in the United Staes. Because we have lirle competition in
Ewope, we anticipate high sales during the first year snd increases of 30% ad 60% during the
second and third years, respectively.
The spresdsheet end sccompenying bargraph below highlight the current seles projections for
Seaum:
[EALES PROJECTIONS (in miflions of $) |
REGION YEAR 1 YEAR 2| YEARY
Region 1
GreatBritain 206] 27.81 R4
Ireland 23 30 3
Tod 29 0L 36
Region 2
Bdgum 749 SS9 11
France 119 1607 19
Gamany 2100 2 o< »
Luxembourg aog a 4
Natharlands 3 4 &
Swrzerland 7. S 11
Tod 53680 7263 8
Region 3
ldy a4 13 3
Patugdl 4 65| %
Spain 1150 15.3;‘ B
To 4] 3321 o<
Region 4
Denmark &£53 7 8
Finland By 7 ]
Norway a8sq 12 14
Sweden 10 1377 16
Tod feates 4091 48
Tod for &l regions o7.0q 144,25 71
PropctSaum FriMay 11, 1950 2
Second page of preview
Exiting the Continue to page through the previewed document until you come
reviewer :
P to the end. When you reach the last page, you are ready to exit

the previewer.

¢ Right hold to display the Previewer menu. Highlight Exit.
Release.
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Setting print
options

& BBN/SlatelPagaiPrevieweriisPageibiofi6s

IMARKETSHARE ~ [EXPECTED REVENUE

(Percentage) i(in milions of $}
1 21

7
21
B7

TOTAL MARKET
in millions of $)
[Western 100 a2
{Maovwasem &4 a1
Cental 49 ug
E. Seaboad == o
TOTAL

B

Percentage of Revenue
By Region

Midwestern

Central

Westem

E. Seaboard

Key Project Goals

Project Saturn will help us remain competitive in our current Europesn and Eastern United States
strongholds and move forwerd in the Westem regions. With Project Saturn, we will also continue
to lead our market segment snd meintain our reputation for quality, innovative software.

Exiting the previewer

Printing your document

After previewing your document, you are ready to send it to the
printer.  You first set up your print options, and then send the
document to the printer.

To set up your printing options, you use the Preview/Print
option and fill in the appropriate information.

Right hold on the Print menu on the menu bar. Highlight

the Preview/Print option. Release.
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Add Edit File Mail Editor  Keycaps

Exit

Project Satdl

Print Now
Define Tables...
Generate Tables

{90

Using the Preview/Print option to set print options

The Preview/Print dialog box appears.
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Page Dimensions Margins
Width: 8.5¢ l Top: 751 Left: .75i

Height: 11i Bottom: .75i Right: .75i

Orientation Page Numbers
@ Portrait Start page number: 1
O Landscape Unnumbered title pages: 0

[ Generate Table of Contents g Print Headers

[0 odd-Even Page Layout

Header
Both Pages:

Footer
Both Pages: Project Saturn~@date~@1

Columns Header /Footer Font
Columns per page: 1 Family £ helvetica
Gutter: .5i Face /¥ Normal

Size /10 pt

Spooling ~

@ To printer O To Previewer
O To File QO setup oOnly

Spooler: Ipr %s [ ok ) (cancer )

The Preview/Print dialog box

Notice that the footer information you entered earlier is still in
place.

Using this dialog box, you can set page dimensions, margins, and
orientation (whether the document prints vertically or horizontally).
You can also tell BBN/Slate whether to create a table of contents
for the document.

For now, you are only interested in printing the document with its
footers. You need to make sure that the spooling information is
set correctly. The spooling information contains the operating-
system command you usually use to send files to the printer plus a
placeholder (%s) for the document name.
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In the figure below, the Spooler field contains the command
lpr %s. The word lpr is an operating-system command used to
send files to the printer, and %s is a placeholder for the name
Presentation. Your operating-system command may be

different.
Page Dimensions Margins
Width: 8.5i Top: 750 Left: .75i
Height: 11i Bottom: .75i Right: .75i
Orientation Page Numbers
® Portrait Start page number: 1
QO Landscape Unnumbered title pages: 0

[0 Generate Table of Contents MPrint Headers

[J odd-Even Page Layout

Header
Both Pages:

Footer
Both Pages: Project Saturn~@date~@ 1

Colurmns Header/Footer Font
Columns per page: 1 Family £ helvetica
Gutter: .5i Face £ Normal

Size [»10pt

Spooling
@ To printer O To Previewer
O To File O Setup Only

Spooler}’lpr s [LGKT] ( Cancel ]

/

Printing
command

Spooling information in the Preview/Print dialog box

¢ Determine if the command listed in the Spooler field is
correct for your operating system.
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Exiting from the
document editor

If you don’t know whether this command is correct, contact your
system administrator.

¢ If the command listed is incorrect, left click at the end of the

command. Delete the command listed using the Delete key
and enter the correct command.

You are now ready to print.

¢ Left click on OK.

While BBN/Slate is creating the PostScript version of your
document, it remains on screen and you see an hourglass instead of
a cursor. When BBN/Slate finishes creating this version, you see
the cursor again.

If BBN/Slate has trouble printing your document, you will see a
message stating the reason. Contact your system administrator if
you cannot print from your workstation.

Exiting from BBN/Slate

You are finished working through this tutorial, so you can exit
from the document editor and from BBN/Slate. Before you exit,
save the Presentation document.

> Right hold on the File menu. Highlight the Write option,

then highlight the Same File option. Release.
Your file is now saved.

To exit from the document editor, use the Exit menu on the
menu bar.
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¢ Right hold on the Exit menu. Drag down to highlight the
Exit option. Release.

#BBN/SlateiMultimediagDocumentiEditors SRR
Add Edit File Mail Print Document Editor
Project Saturn Sales Regions

Exiting from the document editor

Because you modified Presentation while setting it up for
printing, BBN/Slate asks you whether to save the modifications.

¢ Left click on the Yes button.

Write out modified buffers before exiting?

[ yes ) (_No ) (Cancel)

The document editor now closes.

Exiting from Now exit from the software.
BBN/Slate

¢ Left click on the done button in the document manager.
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SalesRegions
Outline

smith

(Cshow ) (compose)(__send J(Ccancel ) (ydone ) [+Getting Started [2]
e

Folder: +Newy

(Cconf ) ((mext ) rep;l/)ueletej (folder ) (_save )

/

Left click
here

Your window manager iconifies the document manager and places
it on your desktop. If you decide to re-enter BBN/Slate before
leaving your windowing system, left click on the icon to restart the
software.

What you’ve learned

In this chapter, you have:

¢ added footers to your document
* previewed your document

e printed your document

¢ exited from the document editor
* exited from BBN/Slate

Now move on to the Epilogue to learn about becoming an
advanced BBN/Slate user.
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Creating
multimedia
documents

Working with
media types

You have just put together a practice presentation with the help of
BBN/Slate software. You’ve seen first-hand how BBN/Slate makes
it easy for you to gather information from your colleagues in
remote places, to have other people review your ideas, and to
professionally present the finished product. While preparing this
presentation, you learned a lot about BBN/Slate’s media types and
main features.

What you've learned

During the course of this tutorial, you have learned to work with
multimedia documents, create and edit most of the media types,
share information using electronic mail, and print documents.

You started with text, then gradually added other media types,
including an image, a graphic, spreadsheets, and business graphics.

You created the document in the document editor. Because the
document editor is integrated, you worked with all of the media
types without having to switch to other software programs.

In this tutorial, you learned how to use most of the media types
available in BBN/Slate, including text, spreadsheets, business
graphs, images, and graphics. By working with each media type,
you learned how to use each of the media-type editors.
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Sharing To exchange information with other people, you learned how to

information send multimedia documents through the mail and how to receive
mail from other users. You also learned how to print your
documents.

Managing your While creating, mailing, and printing multimedia documents, you

work learned to manage your work within BBN/Slate.

By working through the chapters in this tutorial, you also became
familiar with the document manager and the document editor, and
learned how to:

* open folders and files

* create folders

¢ create new documents

* move around in a document

* close a document

* open multiple files

* copy files

» exit from the document editor

* exit from BBN/Slate

As you managed your work, you became comfortable using the
mouse to select options from menus, manage files and folders, and
respond to dialog boxes.

Moving on from here

You have accomplished a lot by going through this tutorial and
have learned enough to use BBN/Slate in your everyday work. As
you continue to use BBN/Slate, you’ll discover other ways to make
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Becoming an
advanced user

your work easier and faster. Not only will you become more
advanced in the topics you’ve seen a glimpse of here, but you will
also learn about other features, such as conferencing, enclosures,
and speech.

While working with media types in this tutorial, you learned about
the basic operations for each one. As you work more with
BBN/Slate, you’ll become acquainted with these more advanced
features:

Text. BBN/Slate comes with a variety of templates, which you
can use and adapt for yourself. Create your own templates for the
kinds of documents you create often, such as monthly reports and
letters. Other advanced text features include a spelling checker,
automatic section and figure numbering, and the Multilingual
Option, which allows you to write in different languages.

BBN/Slate makes frequent backup copies of your document
through a process called checkpointing. Every so often, BBN/Slate
saves your document to a UNIX file with the extension CKP. If
you should accidently leave BBN/Slate without saving your
document, you can use the CKP file as a backup. CKP files do
not appear in the document summary pane. Be aware that CKP
files may not contain your most recent changes. To be sure you
don’t lose any information, frequently save the document yourself.

Spreadsheets. Using the spreadsheet editor, you can sort entire
spreadsheets or regions of spreadsheets by one value or several.
You can generate line graphs as well as bargraphs and piecharts,
and you can read in data from or write data to Lotusl-2-3™
spreadsheets.

Graphics and images. In addition to the features you worked
with, you can add arrows to any graphics and edit any objects to
change the line thickness, line pattern, or fill patterns. As well as
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importing black-and-white images, you can import color images
from your file system or capture images from your workstation
display. You can scale, invert, and reflect entire images or any
part of them.

Electronic mail. Because electronic mail is easy to use in
BBN/Slate, you may soon find yourself using mail for multiple
tasks. For example, if you have a company or department
newsletter, put it in BBN/Slate and distribute it electronically.
You’ll save yourself time and paper.

You might benefit unexpectedly from using multimedia mail.
Because you can communicate complex ideas quickly, you will be
able to make well-informed decisions faster.

Document management. In the document manager, you can sort
files, delete files, delete or rename folders, move files from one
folder to another, and even link folders to particular directories in
your file system. BBN/Slate also lets you set folder permissions
so that only certain users or groups may read or write to specified

folders.
Learning other Experiment with other features that you didn’t try out in this
features tutorial.

Speech. If you have the appropriate workstation configuration,
you can insert and play back digitized voice annotations. Use the
speech feature to make comments on documents you are reviewing
for other people, to personalize mail messages, or to add interest to
on-line newsletters.

Conferencing. BBN/Slate includes a feature that lets you confer
over documents with other users. Several people can confer at the
same time, although only one person can take control of the
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Repeating the
tutorial

document at once. If you own the document, you can decide
whether or not to save the changes made during the conference. A
similar feature is the conversation window, which lets you confer
by typing a dialog with other BBN/Slate users.

Enclosures. What if you need to send an external file to a
BBN/Slate user? Using a multimedia document as an envelope,
you can send data from UNIX files, the executable file itself, or a
reference to the file to anyone using BBN/Slate. By including an
executable file as an enclosure, you can turn BBN/Slate into a
control panel to control other programs.

Extension language. BBN/Slate contains its own programming
language that lets you customize your own environment or that of
your work group. You can use the Slate Extension Language
(SEL) to automate many of the routine tasks that you do every
day.

If you want to go through the tutorial again, first delete the +New
folder and all the documents in it. First, make sure you are in
BBN/Slate.

¢ Using the left mouse button, double-click on the name +New in

the folder list.

& Right hold on the folder button.
¢ Highlight the Delete Folder option.

¢é Release.
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$<MailBox>) il 0 of@iliselected;

#iBBN/Slate::Folder; S 15
BBN Welcome to BBN/Slate Release 1.1

4 Apr 90

=
((show ) (compose)(__send )( cancel ) (_done ) [+Getting Started [2]
.
Commit Changes, Switch to Foider

ges,
Folder: +Nel Discard Changes, Switch to Folder |

Jil: Delete:Folder il
(_conf ) (_next )( reply )( delete ) iii
Rename

Set Permissions

Deleting a folder

Because this folder contains files, BBN/Slate asks whether to delete
the folder and all the files in it.

The folder is not empty.
Delete it anyway?

Lo ) (e )

Deleting a folder containing documents

Answer yes.
¢ Left click on the OK button.
You can now repeat the tutorial.

Finding out more To learn more about BBN/Slate, see the Reference Manual, the

information Customizing Manual, the System Topics manual, and if you have
the Multilingual Option, the Multilingual Documents manual. The
more you work with BBN/Slate, the more you’ll discover new
ways to make BBN/Slate work for you.
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Document-Set Language/Font 3-26
Edit-Change Attributes 5-39, 6-5
Edit-Copy 6-11
Editor-Buffer 4-21
Editor-Buffer-Switch To 4-21, 6-12
Edit-Paste 6-14
File-Write-New File 3-35
File-Write-Same File 6-43, 7-15
Folder-Delete folder 8-5
Graphics-Edit-Duplicate 6-25
Graphics-Edit-Scale 6-16
Graphics-Palette 6-21
Graphics-Style-Font 6-40
Mail-Send 4-4
Mail-Send as Multimedia 4-4
Mail-Send-Send Message 4-14
Previewer-Next Page 7-9
for printing 7-11
Print-Preview/Print 7-2
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options (continued)
Save-Copy Selected Documents to Folder 2-28
Sheet-Fill Down 5-24
Sheet-Graph-Create 5-41
Sheet-Graph-Generate 5-6
Sheet-Rulings 5-31
Show-Show Document with Previous
Document 6-9
Text-Add-enumeration 3-13
Text-Add-noindent 3-7, 4-2
Text-Edit-Cut 3-21
Text-Edit-Paste 3-22
Text-Styles-Local Change 3-29
orientation during printing 7-13
outlines
around images 6-7

print options
setting 7-11
printing 7-1
adding date 7-2
adding footers 7-2
command 7-14
creating table of contents 7-13
orientation 7-13
page dimensions 7-13
previewing 7-6
setting margins 7-13
setting up 7-1
spooling information 7-13
Print-Preview/Print option 7-2

R
P Range field
in piecharts 5-45
page reading
setting dimensions 7-13 mail 4-16
page icon next mail message 4-20

using to scroll vertically 2-17

paging through a document 2-17
Palette option

Graphics menu 6-21

panes

in document manager 2-3

Paste option

Edit menu 6-14

recalculating formulas in spreadsheets 5-5
receiving mail 4-16
regenerating graphs 5-5
renumbering lists 3-20
repeating the tutorial 8-5
resizing spreadsheets 5-28
rulings
adding to spreadsheets 5-31

pasting rulings dialog box
graphics 6-12 Add button 5-33
text 3-20 Apply button 5-33

patterns Clear button 5-37

using 6-31 Keep Up button 5-32
permissions Take Down button 5-38
setting folder 8-4
piecharts
creating 5-40 S

defining values 5-43

links to spreadsheets 5-47
positioning objects 6-29
Postscript printers

printing to 7-1
previewer

Same File option 6-43, 7-15
Save-Copy Selected Documents to Folder
option 2-28
saving documents 3-35
Scale option
exiting 7-10 Graphics menu 6-16
moving through documents in 7-8 screen dumps 8-4
Previewer menu 7-8 screens

previewer window 7-7 start-up 2-2
Previewer-Next Page option 7-9 scroll bars
previewing documents before printing 7-6 using 2-11
Preview/Print option 7-2, 7-6 scroll bubble

Print menu 7-2 vertical 2-13

Index-5



scrolling through a document 2-11
selecting

text 3-20
selecting spreadsheet cells 5-4
Send option 4-4
sending documents< 4-1
setting

font family 3-27

font size 3-27

print options  7-11
Sheet menu 5-6
Sheet-Edit-Fill Down option 5-24
Sheet-Graph-Create option 5-41
Sheet-Graph-Generate option 5-6
Sheet-Rulings option 5-31
shortcuts

keyboard 5-48

Show Document with Previous Document

option 6-9

size

changing text 3-29
sorting

in spreadsheets 8-3
speech media type 1-3, 8-4
spelling checker 8-3
spooling information

for printing 7-13
spreadsheet media type 1-2
spreadsheets

adding 5-8

calculations in 5-24

cellsin 5-4

changing values 5-3

copying formulas within 5-24

correcting mistakes 5-20

creating 5-1, 5-8

creating graphics from 5-40

defining graph types 5-42

defining values for graphs 5-43

editing 5-3

entering formulas 5-22

entering numbers in  5-20

formulas in 5-5, 5-11

handles 5-28

labels in 5-11

links to graphs 5-47

media type 5-1

moving across 5-18

moving down 5-18

moving within 5-9

numbers in 5-11

resizing 5-28

rulings in 5-31

spreadsheets (continued)
sorting 8-3
specifying a range of cells 5-27
types of values in 5-11
starting BBN/Slate 2-2
start-up screen 2-2
status messages 4-8
storing documents 3-35
stretching objects 6-30
style
changing type 3-26
styles
text 3-7
Switch To option 6-12

T

table of contents

creating during printing 7-13
Take Down button

Graphics palette 6-42

rulings dialog box 5-38
templates 3-5
text

adding to graphics 6-34

centering 3-9

changing in graphics 6-40

correcting mistakes 3-8

cutting 3-20

editing 3-24

enlarging 3-29

entering 3-6

highlighting 3-20

media type 1-2, 3-1

pasting 3-20

styles 3-7

working with 3-3
Text menu 3-7
text styles

adding 4-2

noindent 4-2
Text-Add-enumeration option 3-13
Text-Add-noindent option 3-7, 4-2
Text-Edit-Cut option 3-21
Text-Edit-Paste option 3-22
Text-Styles-Local Change option 3-29
titles

adding to graphics 6-38

for business graphs 5-42
tutorial

repeating 8-5
type style

changing 3-26
types of values in spreadsheets 5-11
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U

using electronic mail 4-1
using the mouse 2-4

\Y%

values
changing in spreadsheets 5-3
defining for piecharts 5-43
entering in spreadsheets 5-20
vertical movement 2-12
vertically
moving 2-12

\

windowing system 2-2
working with text 3-3

X

XRange field
in piecharts 5-43
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BBN Software Products
A Division of Bolt Beranek and Newman Inc.

Your opinions about our products and services are important to us. Please use this self-addressed,
stamped form to help us evaluate this manual. Your response to the questions listed below will
help us assess our current documentation and plan ways to improve it to meet your needs. Just
fill in your responses, detach this sheet, fold and tape it, and drop it in the mail. We’ll pay careful

attention to what you say!

Manual Title: BBN/Slate Getting Started (Release 1.1)

List your operating system: Date: /
General Comments: Yes Somewhat No
Do you like this manual? a O ]
Is it easy to read? a d a
Is the order of topics easy to follow? O d a
Is the information accurate? O O a
Can you easily find the information you need? O O O
Do the examples and illustrations help? ] O a
Can you easily apply the described features O d O
to your own needs?

Do you use on-line help? a O g

Comments and Suggestions (include chapter or page number where applicable):

How do you primarily use this manual?

O Introduction O Tutorial
O Check here to receive information about our Education Services.

O Check here to receive the BBN Software Quarterly newsletter.

O Reference

Please fill in the following information:

Name Title
Company Street
City State

Zip Code Phone




BUSINESS REPLY ENVELOPE

FIRST CLASS PERMIT NO. 36450 CAMBRIDGE, MA

POSTAGE WILL BE PAID BY ADDRESSEE

. BBN Software Products
A Division of Bolt Beranek and Newman Inc.
10 Fawcett Street
Cambridge, MA 02138

Attn: Manager, Documentation

NO POSTAGE
NECESSARY
IF MAILED
IN THE
UNITED STATES
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This manual is designed to
lie flat on your desktop.
When using the manual,
tuck this flap inside the
back cover. When storing
the manual on your
bookshelf, tuck the flap
inside the front cover.
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